
 

 

 

 

 

 

  

 

 

 

 

 

  

  

 

 

 

 

คูมือการปฏิบัติงาน 
 

การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเนต็ 
 
 

นางสาวดลวรรณ สุทธิวัฒนกำจร 
 

 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 



คำนำ 
 

 กลุ มนว ัตกรรมและเทคโนโลยีการศึกษา ส ํานักว ิทยบริการและเทคโนโลยีสารสนเทศ 

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร มีภาระกิจหลักในการสนับสนุน ผลิตและพัฒนานวัตกรรม                             

สื่อการเรียนการสอน พัฒนาระบบการเรียนการสอนโดยใชเทคโนโลยีสารสนเทศ รวมถึงการสนับสนุน เผยแพร

และประชาสัมพันธกิจกรรมตาง ๆ  ของทางมหาวิทยาลัย สําหรับการผลิตภาพกราฟกเปนสวนหนึ่งในการ

เผยแพรและประชาสัมพันธมหาวิทยาลัย คูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ตเลมนี้ จึงเปนคูมือการปฏิบัติงานสำหรับเจาหนาที่กลุมนวัตกรรมและเทคโนโลยีการศึกษา      

สํานักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เพื่อใชเปนแนวทาง   

ในการปฏิบัติงานใหกับเจาหนาที่สามารถปฏิบัติงานแทนกันไดและใหการปฏิบัติงานเปนไปในทิศทางเดียวกัน 

โดยผูจัดทําคูมือปฏิบัติงานไดรวบรวมความรูประสบการณในการทํางานและไดศึกษาเพิ่มเติมจากแหลงขอมูล 

ตาง ๆ เพื่อใหคูมือปฏิบัติงานเลมน้ีสมบูรณ นำไปใชในการปฏิบัติงานไดจริงและเกิดประสิทธิภาพสูงสุด 

 

นางสาวดลวรรณ สุทธิวัฒนกำจร 

 นักวิชาการชางศิลปปฏิบัติการ 

 



สารบัญ 
        หนา 

บทที่ 1 บทนํา           1 

1.1 ความเปนมาและความสําคัญ        1 

1.2 วัตถุประสงค          2 

1.3 ประโยชนที่คาดวาจะไดรับ        2 

1.4 ขอบเขตของคูมือ         2 

1.5 คําจํากัดความเบื้องตน        2 

บทที่ 2 โครงสรางและหนาที่ความรับผิดชอบ       3 

2.1 โครงสรางการบริหารจัดการ        5 

2.2 บทบาทหนาที่ความรับผิดชอบ        10 

บทที่ 3 หลักเกณฑวิธีการปฏิบัติงาน        14 

3.1 องคประกอบศิลป         15 

3.2 หลักการออกแบบ         21 

3.3 คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc     24

 3.4 สวนประกอบในหนาตางของโปรแกรม Adobe Photoshop cc    33 

3.5 คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc    48 

3.6 ขอควรระวังในการปฏิบัติงาน        56 

บทที่ 4 เทคนิคการปฎิบัติงาน         57 

4.1 การสรางไฟลเอกสารใน Adobe Photoshop cc     57 

4.2 การผลิตภาพกราฟกภาพพักหนาจอ       64 

4.3 การผลิตภาพกราฟกแถบชื่องาน       82 

4.4 การผลิตภาพกราฟกแถบชื่อผูรวมงาน       91 

4.5 การบันทึกไฟลภาพกราฟก        100 

4.6 การติดตามประเมินผลการปฏิบัติงาน       105 

บทที่ 5 ปญหา อุปสรรคและขอเสนอแนะ        106 

5.1 ปญหาอุปสรรค         106 

5.2 แนวทางการแกไขปญหา        107 

5.3 ขอเสนอแนะ          109 

บรรณานุกรม           111 

 

 



สารบัญภาพ 
        หนา 

ภาพท่ี 2-1 แสดงโครงสรางหนวยงานของสํานักวิทยบริการและเทคโนโลยีสารสนเทศ   5 

ภาพท่ี 2-2 แสดงโครงสรางการบริหารสํานักวิทยบริการและเทคโนโลยีสารสนเทศ   6 

ภาพท่ี 2-3 แสดงโครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา            7  

              สํานักวิทยบริการและเทคโนโลยีสารสนเทศ 

ภาพท่ี 2-4 แสดงแผนผังขั้นตอนการปฏิบัติงานการผลิตภาพกราฟกสําหรับการถายทอดสัญญาณภาพ 13  

              และเสียงออกอากาศผานทางระบบอินเทอรเน็ต 

ภาพท่ี 3-1 ลักษณะพิกเซลของภาพ        25 

ภาพท่ี 3-2 ตัวอยางภาพถายขนาด 4x6 น้ิว ความละเอียด 72 pixels/inch มีจํานวนพิกเซลทั้งหมด 26 

              124,416 pixels     

ภาพท่ี 3-3 การขยายภาพแบบ Bitmap จนเห็นพิกเซลเรียงตัวกันเปนตาราง     27 

ภาพท่ี 3-4 เปรียบเทียบความละเอียดของภาพระหวาง 72 ppi (ซาย) และ 300 ppi (ขวา)  28 

ภาพท่ี 3-5 Hue ที่แทนคาสีดวยองศา        29 

ภาพท่ี 3-6 แสดงความสดของสี         30 

ภาพท่ี 3-7 แสดงความสวางและความมืดของสี       30 

ภาพท่ี 3-8 การผสมสีแบบบวก (additive color mixing)      31 

ภาพท่ี 3-9 การผสมสีแบบลบ (Subtractive Color Mixing)      31 

ภาพท่ี 3-10 สวนประกอบของโปรแกรม Adobe photoshop cc     33 

ภาพท่ี 3-11 แถบคำสั่ง Menu Bar        34 

ภาพท่ี 3-12 การเลือกใชคำสั่งยอยใน Menu Bar       34 

ภาพท่ี 3-13 คียลัดที่ใชเรียกคำสั่งของ Menu Bar       35 

ภาพท่ี 3-14 Option Bar ของ Type tool        35 

ภาพท่ี 3-15 วิธีบันทึกคาเคร่ืองมือที่ตองใชเปนประจำ      36 

ภาพท่ี 3-16 เคร่ืองมือยอยของ Selection        41 

ภาพท่ี 3-17 ตัวอยาง Character Panel และ Swatches Panel     41 

ภาพท่ี 3-18 การยอ-ขยายของ Panel        42 

ภาพท่ี 3-19 การปด Panel         42 

ภาพท่ี 3-20 การซอน-แสดง Panel        43 

ภาพท่ี 3-21 การเรียกใชงาน Panel        43 

ภาพท่ี 3-22 การทำงานใน Workspace Essentials [Default]     44 

ภาพท่ี 3-23 การทำงานใน Workspace 3D       44 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 3-24 การทำงานใน Workspace Graphic and Web     45 

ภาพท่ี 3-25 การทำงานใน Workspace Motion       45 

ภาพท่ี 3-26 การทำงานใน Workspace Painting       46 

ภาพท่ี 3-27 การทำงานใน Workspace Photography      46 

ภาพท่ี 3-28 การเรียกใชงาน Workspace โดยการคลิก Window ตรง Menu bar    47 

ภาพท่ี 3-29 การเรียกใชงาน Workspace โดยการคลิกปุม             มุมบนขวาของโปรแกรม  47 

ภาพท่ี 3-30 พื้นที่การทำงานของ Artboard       48 

ภาพท่ี 4-31 การต้ังคาไฟลเอกสาร         57 

ภาพท่ี 4-32 หนาตาง Preset         58 

ภาพท่ี 4-33 แสดงการใชงานไฟลลาสุด        58 

ภาพท่ี 4-34 ไฟลเอกสารที่ไดบันทึก         59 

ภาพท่ี 4-35 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Photo     59 

ภาพท่ี 4-36 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Print    60 

ภาพท่ี 4-37 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Art & Illustration   60 

ภาพท่ี 4-38 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Web    61 

ภาพท่ี 4-39 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Mobile    61 

ภาพท่ี 4-40 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Film & Video   62 

ภาพท่ี 4-41 รูปแบบตางๆ ที่โปรแกรมกำหนด       62 

ภาพท่ี 4-42 หนาตาง Preset Detail        63 

ภาพท่ี 4-43 ไฟลเอกสารที่สรางสำเร็จ        64 

ภาพท่ี 4-44 วิธีเปดโปรแกรม Adobe Photoshop cc      65 

ภาพท่ี 4-45 หนาจอเมื่อโปรแกรม Adobe Photoshop cc เปดใชงาน    65 

ภาพท่ี 4-46 การสรางไฟลเอกสาร         66 

ภาพท่ี 4-47 การต้ังคาไฟลเอกสาร         66 

ภาพท่ี 4-48 การกำหนดภาพพื้นหลังของไฟลเอกสาร      67 

ภาพท่ี 4-49 การต้ังชื่อไฟลเอกสาร        67 

ภาพท่ี 4-50 หนาจอแสดงไฟลเอกสาร Background  ที่ไดสรางไว     68 

ภาพท่ี 4-51 หนาจอแสดงการเปดไฟลรูป        68 

ภาพท่ี 4-52 หนาจอแสดงการเลือกไฟลรูป        69 

ภาพท่ี 4-53 รูปภาพที่เลือกในไฟลเอกสาร Background      69 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 4-54 คลิกเลือก Layer รูปภาพ ใน Layer Panel      70 

ภาพท่ี 4-55 คัดลอกรูปภาพโดยใช Menu Edit       70 

ภาพท่ี 4-56 เลือกไฟลเอกสารที่ตองการวางรูปที่คัดลอกมา      71 

ภาพท่ี 4-57 วาง Layer ที่ Copy มา โดยใช Menu Edit      71 

ภาพท่ี 4-58 ไฟลรูปภาพในไฟลเอกสาร Background      72 

.ภาพท่ี 4-59 ใชคำสั่ง Edit -> Transform        72 

ภาพท่ี 4-60 การเลือก Move Tool         72 

ภาพท่ี 4-61 การจัดวางรูปภาพใหเหมาะสมกับขนาดของพื้นที่     73 

ภาพท่ี 4-62 ใส Filter Gaussian blur        73 

ภาพท่ี 4-63 กำหนดคา Radius ใน Filter Gaussian blur      74 

ภาพท่ี 4-64 รูปภาพที่ใส Filter Gaussian blur       74 

ภาพท่ี 4-65 Horizontal Type Tool ที ่Toolbox       75 

ภาพท่ี 4-66 Option bar กำหนดรายละเอียดของตัวอักษรกลุมชื่องาน    75 

ภาพท่ี 4-67 ขอความที่พิมพลงไป         76 

ภาพท่ี 4-68 ยายขอความโดยใช Move Tool       76 

ภาพท่ี 4-69 จัดแตงขอความโดยใช Character Panel       76 

ภาพท่ี 4-70 ขอความที่จัดแตงสำเร็จ        77 

ภาพท่ี 4-71 เรียกใชคำสั่ง Effect Stroke ที่ Menu Layer      77 

ภาพท่ี 4-72 เรียกใชคำสั่ง Effect Stroke ที่ Layer  Panel      77 

ภาพท่ี 4-73 กำหนดคาตางๆ ในหัวขอ Stroke       78 

ภาพท่ี 4-74 ขอความชื่องานที่จัดทำสำเร็จ         78 

ภาพท่ี 4-75 Option bar กำหนดรายละเอียดของกลุมขอความรายละเอียดของงาน   79 

ภาพท่ี 4-76 ขอความรายละเอียดของงาน        79 

ภาพท่ี 4-77 กำหนดคาในหัวขอ Stroke        80 

ภาพท่ี 4-78 ขอความรายละเอียดของงานที่จัดแตงสำเร็จ      80 

ภาพท่ี 4-79 ไฟลภาพพักหนาจอที่จัดทำสำเร็จ       81 

ภาพท่ี 4-80 ตัวอยางภาพพักหนาจอพิธีไหวครูในการถายทอดสดผาน Facebook live    81 

ภาพท่ี 4-81 ตัวอยางภาพพักหนาจองานปจฉิมนิเทศนักศึกษาในการถายทอดสดผาน Facebook live  82 

ภาพท่ี 4-82 เปดไฟลเอกสารที่ไดบันทึกไวโดยคำสั่ง Open      83 

ภาพท่ี 4-83 เลือกไฟลที่ตองการเปด        83 



สารบัญภาพ (ตอ) 
        หนา 

ภาพท่ี 4-84 ไฟลเอกสารที่ไดบันทึกไว        84 

ภาพท่ี 4-85 Rectangle Tool ที่ Toolbox       84 

ภาพท่ี 4-86 กำหนดคาของแถบชื่อที่ Option bar       85 

ภาพท่ี 4-87 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง     85 

ภาพท่ี 4-88 สี่เหลี่ยมผืนผาที่สรางสำเร็จ        85 

ภาพท่ี 4-89 Move Tool สำหรับเคลื่อนยาย       86 

ภาพท่ี 4-90 เสนไกดแนวนอนเสนที่ 3        86 

ภาพท่ี 4-91 สี่เหลี่ยมที่ยายลงมาดานลาง        87 

ภาพท่ี 4-92 คำสั่ง Skew ที่ Menu Bar -> Edit       87 

ภาพท่ี 4-93 ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน     88 

ภาพท่ี 4-94 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ        88 

ภาพท่ี 4-95 Horizontal Type Tool        88 

ภาพท่ี 4-96 Option bar กำหนดรายละเอียดของตัวอักษร      89 

ภาพท่ี 4-97 ขอความที่พิมพลงไป         89 

ภาพท่ี 4-98 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool  และ Character Panel  89 

ภาพท่ี 4-99 ขอความที่จัดแตงสำเร็จ        90 

ภาพท่ี 4-100 ตัวอยางกราฟกแถบชื่อการบรรยายในกิจกรรมปฐมนิเทศนักศึกษา    90 

                  ในการถายทอดสดผาน  Facebook live 

ภาพท่ี 4-101 ตัวอยางกราฟกแถบชื่องานในการสัมมนาผาน Facebook live    90 

ภาพท่ี 4-102 Rectangle Tool ที่ Toolbox       91 

ภาพท่ี 4-103 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีมวง     92 

ภาพท่ี 4-104 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง     92 
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บทที่ 1 

บทนำ 

1.1 ความเปนมาและความสำคัญ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เปนหนวยงาน

ที่สนับสนุนภาระกิจหลักของมหาวิทยาลัยในการนำนโยบายดิจิตัลเพื่อเศรษฐกิจและสังคม เขามามีบทบาทใน

การพัฒนากระบวนการจัดการศึกษา โดยใหบริการดานเทคโนโลยีสารสนเทศในการเรียนการสอน การ

คนควาวิจัย พัฒนาและผลิตสื่อสนับสนุนการเรียนการสอนที่มีคุณภาพ พัฒนาระบบการเรียนการสอนโดยใช

เทคโนโลยีสารสนเทศ และผลิตสื่อในทุกรูปแบบแกนักศึกษา คณาจารย และเจาหนาที่ของมหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร สำนักวิทยบริการและเทคโนโลยีสารสนเทศ ไดแบงโครงสรางการบริหารงาน

ออกเปน 5 กลุมงาน ไดแก กลุมวิทยบริการ กลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา กลุมเทคโนโลยี

สารสนเทศ กลุมเครือขายคอมพิวเตอรและการสื่อสาร และงานบริหารทั่วไป กลุมพัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา เปนหนวยงานที่มีภาระกิจหลักในการสนับสนุน ผลิตและพัฒนานวัตกรรมสื่อการเรียน

การสอน พัฒนาระบบการเรียนการสอนโดยใชเทคโนโลยีสารสนเทศ เชน ผลิตสื่อการเรียนการสอนทางไกล

ผานดาวเทียม สื่อ e-Learning รวมถึงสนับสนุน เผยแพรและประชาสัมพันธกิจกรรมตาง ๆ ของมหาวิทยาลัย 

ทั้งภายในและภายนอกองคกร เชน การบันทึกภาพเคลื่อนไหว การบันทึกภาพนิ่ง การบันทึกเสียง การผลิต  

สื่อวีดิทัศน การผลิตสื่อมัลติมีเดีย การผลิตสื่อสิ่งพิมพ งานถายทอดสดผานระบบอินเทอรเน็ต งานควบคุม

ระบบเสียง สำหรับการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตนั้น เปนสวนหนึ่งของ      

งานถายทอดสดผานระบบอินเทอรเน็ต มีวัตถุประสงคเพื ่อเผยแพรและประชาสัมพันธก ิจกรรมตาง ๆ        

ของมหาวิทยาลัยใหเปนที่รูจัก 

 การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต เปนการผลิตภาพกราฟกประกอบการ

ถายทอดสดผานระบบอินเทอรเน็ต เมื่อการถายทอดสดเร่ิมตนจะพบกับกราฟกภาพพักหนาจอ บอกชื่องาน 

วัน เวลาและสถานที่จัดงาน เปนภาพแบบเต็มหนาจอ เมื่อการถายทอดสดออกอากาศไปไดระยะเวลาหน่ึง   

จะมโีลโกมหาวิทยาลัยและโลโกกิจกรรมขนาดยอสวนขึ้นอยูที่มุมใดมุมหน่ึงของจอ เพื่อบอกใหผูชมรับทราบวา

กำลังรับชมกิจกรรมอะไรของมหาวิทยาลัยอยู หากในการถายทอดสดมีพิธีกรดำเนินรายการ มีประธานในงาน

หรือวิทยากรมาพูดใหความรู จะมีกราฟกบอกชื่อ นามสกุลและตำแหนง เพื่อเปนการใหเกียรติแกบุคคลน้ัน ๆ 

และบอกผูรับชมใหทราบวาเปนใคร นอกจากน้ียังมีกราฟกที่ม ีลักษณะเปนแถบเล็ก ๆ อยูดานลางจอ         

เปนกราฟกบอกชื่องาน จะขึ้นอยูเปนระยะ ๆ ในการถายทอดสด เพื่อใหผูชมที่เพิ่งเขามารับทราบวาน่ีคือ การ

ถายทอดสดงานใด ในสวนรูปแบบของภาพกราฟกที่ตองการนำเสนอขึ้นอยูกับความคิดสรางสรรคของผูสราง

งานและรูปแบบของกิจกรรมวาเปนกิจกรรมในรูปแบบใด มีการวางแนวทางงานกราฟก ไมวาจะเปนกราฟก

บอกชื่องาน โลโก โทนสี ลักษณะตัวอักษร รูปแบบของกราฟก จะตองมีความสอดคลอง เหมาะสมกับรูปแบบ

ของกิจกรรม สำหรับการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตโดยการใชโปรแกรม 
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Adobe Photoshop cc นั้น ผูปฏิบัติงานจำเปนจะตองทราบถึงคุณสมบัติเฉพาะทางเทคนิคของโปรแกรม 

Adobe Photoshop cc ดังนั้นผูปฏิบัติงานที่มีหนาที่ที ่เกี่ยวของจำเปนจะตองศึกษาและมีแนวทางปฏิบัติที่

เปนไปในทางเดียวกัน เพื่อใหการผลิตภาพกราฟกมีมาตรฐานและเกิดประโยชนสูงสุดตอหนวยงานและ

มหาวิทยาลัย  

 จากความเปนมาและความสำคัญดังกลาว จึงไดจัดทำคูมือปฏิบัติงานเร่ืองการผลิตภาพกราฟกในการ

ถายทอดสดผานระบบอินเทอรเน็ตขึ้นมา เพื่อใหผูปฏิบัติงานสามารถปฏิบัติงานแทนกันไดและใชเปนแนวทาง

ในการปฏิบัติงานใหมีมาตรฐานและเปนไปในทิศทางเดียวกัน  

 

1.2 วัตถุประสงค 

1. เพื่อจัดทำคูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต 

2. เพ ื ่อใหผู ปฏ ิบ ัต ิงานทราบถึงขั ้นตอนในการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ต 

3. เพื่อใหผูปฏิบัติงานรูจักโปรแกรม Adobe Photoshop cc เบื้องตน 

  

1.3 ประโยชนที่คาดวาจะไดรับ  

1. ผูปฏิบัติงานสามารถปฏิบัติงานแทนกันได  

2. ใหการปฏิบัติงานมีมาตรฐานและเปนไปในทิศทางเดียวกัน 

3. ผูปฏิบัติงานมีความรูความเขาใจในโปรแกรม Adobe Photoshop cc เบื้องตน  

 

1.4 ขอบเขตของคูมือ 

  คู ม ือปฏิบ ัติงานเล มนี ้ ครอบคลุมข ั ้นตอนการผลิตภาพกราฟกในการถายทอดสดผานระบบ

อินเทอรเน็ต โดยใชโปรแกรม Adobe Photoshop cc ตั้งแตขั ้นตอนการเริ ่มตนสรางภาพกราฟ กด วย

คอมพิวเตอรจนสิ้นสุดกระบวนการในขั้นตอนของการบันทึกไฟลภาพกราฟกของเจาหนาที่ผูปฏิบัติงาน ทั้งจาก

หนวยงานภายในและภายนอกมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร เมื่อมีการรองขอ 

 

1.5 คำจำกัดความเบ้ืองตน 

 โลโก หมายถึง ตราสัญลักษณของมหาวิทยาลัยหรือคณะตาง ๆ ในมหาวิทยาลัย 
 ภาพกราฟก หมายถึง รูปภาพทีแ่สดงขอมูลของกิจกรรมที่กำลังถายทอดสด 

Adobe Photoshop cc หมายถึง โปรแกรมผลิต ตกแตง แกไข ภาพกราฟกที่ใชในการถายทอดสด 

 คอมพิวเตอรกราฟก หมายถึง การสราง ตกแตง แกไข หรือจัดการภาพกราฟกดวยคอมพิวเตอร 

เครื่องสลับสัญญาณภาพและเสียง หมายถึง อุปกรณเลือกสัญญาณภาพและเสียง ใชสำหรับการ

ถายทอดสดผานอินเทอรเน็ต 
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บทที่ 2 

โครงสราง และหนาทีค่วามรับผิดชอบ 
 

 มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ไดสถาปนาขึ้นตามพระราชบัญญัติมหาวิทยาลัยเทคโนโลยีราช

มงคล เมื่อวันที่ 18 มกราคม พ.ศ. 2548 ประกอบดวยวิทยาเขต 5 แหงไดแก วิทยาเขตเทเวศร วิทยาเขตโชติเวช

วิทยาเขตพณิชยการพระนคร วิทยาเขตชุมพรเขตรอุดมศักด์ิ และวิทยาเขตพระนครเหนือ ขอมูลระบบเครือขาย 

คอมพิวเตอรเดิม แตละวิทยาเขตไดใชเทคโนโลยี ของ Cisco System โดยใช Router เปนอุปกรณคนหาเสนทาง 

เชื่อมตอผาน Leased Line มีBandwidth ขนาด 2 Mb ตอไปที่ สำนักเทคโนโลยีสารสนเทศ สถาบนัเทคโนโลยีราช

มงคล มหาวิทยาลัยเทคโนโลยรีาชมงคลพระนคร ไดดำเนินการจดโดเมนใหม เปน rmutp.ac.th ในวันที่ 8 กันยายน 

พ.ศ. 2548 เพื่อใหสอดคลองกับลักษณะขององคกร 

 ตอมาเมื่อวันที่ 14 พฤศจิกายน พ.ศ. 2549 ไดมีกฎกระทรวง จัดต้ังสวนราชการในมหาวิทยาลัยเทคโนโลยี

ราชมงคล ใหเปนสำนักวิทยบริการและเทคโนโลยีสารสนเทศ โดยมีสำนักงานชั่วคราวตั้งอยูที ่ อาคาร 1 ชั้น 4 

ปจจุบันต้ังอยู ณ อาคารอเนกประสงค มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร วิทยาเขตเทเวศร และมีศูนยวิทย

บริการและเทคโนโลยีสารสนเทศ อีก 4 แหง ไดแก สาขาโชติเวช สาขาพณิชยการพระนคร สาขาชุมพรเขตรอุดม

ศักด์ิและสาขาพระนครเหนือ 

 

วิสัยทัศน พันธกิจ เปาหมาย ยุทธศาสตร กลยุทธ ของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 วิสัยทัศน 

พัฒนาองคกรสูการเปนมหาวิทยาลัยดิจิตัล  

 ปณิธาน 

มุงมั่นเปนผูนำการจัดการศึกษาดานวิชาชีพดวยวิทยาศาสตรและเทคโนโลยีเชิงบูรณาการ  

พัฒนากำลังคนใหมีคุณภาพ คูคุณธรรม สูมาตรฐานสากล 

 พันธกิจ 
พัฒนานวัตกรรมดานไอซีที เพื่อสนับสนุนภารกิจหลักของมหาวิทยาลัยในการกาวไปสูการ 

เปนมหาวิทยาลัยดิจิตัล 

ผลิตการบริการ การศึกษาโดยใชนวัตกรรมดานไอซีที เพื่อบูรณาการเขากับการเรียนการ 

สอนสมยัใหม โดยผานระบบบริการอิเล็กทรอนิกส 

พัฒนาการบริหารจัดการองคกรโดยใชนวัตกรรมดานไอซีที เพื่อเพิ่มประสิทธิภาพและ 

ประสิทธิผลการบริหารการศึกษาสมัยใหมและเปนกลไกในการสรางหลักธรรมาภิบาล 

พัฒนาทรัพยากรบุคคลใหมีสมรรถนะทางไอซีทีที่มีคุณภาพ สอดคลองกับการพัฒนา 

ประเทศ 

จัดหาทรัพยากร ICT โดยใชเทคโนโลยีที่เหมาะสม สอดคลองกับภารกิจของมหาวิทยาลัย 
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 เปาประสงค 
ยกระดับเพิ่มขีดความสามารถของบุคลากรและนักศึกษาในการใชนวัตกรรมดิจิต ัลเพื่อ

การศึกษา 

พัฒนาสื่อและระบบสนับสนุนการเรียนรูในรูปแบบดิจิตัลเพื่อบูรณาการเขากับการเรียนการ 

สอนออนไลน 

สรางวัฒนธรรมการทำงานขององคกรใหเปนสังคมดิจิตัลที่มีคุณภาพ 

สรางระบบนิเวศดิจิตัลสำหรับงานวิจัยอยางครบวงจร เพื่อบูรณาการเขากับการบริหารจัดการ 

งานวิจัยและบริการงานวิชาการ 

สรางระบบบริหารจัดการเชิงกลยุทธ โดยใชเทคโนโลยีการประมวลผลขอมูลขนาดใหญ เพื่อเพิ่ม

ประสิทธิภาพและประสิทธิผลการบริหารจัดการและการพัฒนาองคกร 

พัฒนาโครงสรางพื้นฐานดานไอซีทีที่มีมาตรฐานและทันสมัยดวยเทคโนโลยีดิจิตัล 

  

กลยุทธ 
พัฒนาคุณภาพนักศึกษา (Smart Student)  

พัฒนาคุณภาพบุคลากรสายวิชาการ (Smart Lecturer) 

พัฒนาคุณภาพบุคลากรสายสนับสนุน (Smart Personal)  

พัฒนาคุณภาพระบบการจัดการความรู (Smart Knowledge) 

พัฒนาศูนยความเปนเลิศทางวิชาการ (Center of Excellence) 

พัฒนาคุณภาพหลักสูตรและการเรียนการสอน (Smart Learning)  

พัฒนาทรัพยากรการเรียนรูดิจิทัล (Smart Library) 

พัฒนาระบบงานการใหบริการอิเล็กทรอนิกส (e-Services)  

พัฒนาระบบบริหารและบริการงานวิจัย (e-Research)  

พัฒนาระบบบริหารจัดการเชิงกลยุทธ (e-Strategy)  

พัฒนาระบบประมวลผลขอมูลขนาดใหญ (Big Data) 

พัฒนาระบบการประกันคุณภาพการศึกษา (Quality Assurance) 

พัฒนาโครงสรางพื้นฐานทางดานเทคโนโลยีสารสนเทศและการสื่อสาร (e-Infrastructure) 
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2.1 โครงสรางการบริหารจดัการ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มีโครงสรางของงาน  โครงสรางการบริหารหนวยงาน 

โครงสรางการปฏิบัติงานและภาระหนาที่ของหนวยงาน ดังน้ี 

 

 2.1.1 โครงสรางการบริหารจัดการองคกร 

 

1) โครงสรางหนวยงานของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ (Organization 

chart) 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 2-1 แสดงโครงสรางหนวยงานของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 

 

 

 

 

 

กลุม 

เครือขายคอมพิวเตอร     

และการสื่อสาร 

งาน 

บริหารทั่วไป 

กลุม 

พัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา 

กลุม 

วิทยบริการ 

กลุม 

เทคโนโลยีสารสนเทศ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

สำนักงานผูอำนวยการ 
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2) โครงสรางการบริหารสำนักวิทยบริการและเทคโนโลยีสารสนเทศ (Administration 

chart) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 2-2 แสดงโครงสรางการบริหารสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนากลุม 

เครือขายคอมพิวเตอร     

และการสื่อสาร 

หัวหนางาน 

บริหารทั่วไป 

หัวหนากลุม 

พัฒนานวัตกรรมและ

เทคโนโลยีการศึกษา 

หัวหนากลุม 

วิทยบริการ 
หัวหนากลุม 

เทคโนโลยีสารสนเทศ 

หัวหนาสำนักงานผูอำนวยการ 

รองผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนางาน 

วิทยบริการ 

หัวหนางาน 

หองสมุด 

หัวหนางาน 

วิจัยและพัฒนา

สื่อการศึกษา 

หัวหนางาน 

ผลิตสื่อโสตทัศน 

หัวหนางาน 

พัฒนาระบบเทคโนโลยี

สารสนเทศ 

หัวหนางาน 

ศูนยขอมูลสารสนเทศ 

หัวหนางาน 

พัฒนาระบบเครือขาย

คอมพิวเตอรและ 

การสื่อสาร 

หัวหนางาน 

บริการคอมพิวเตอร 

และระบบเครือขาย 

หัวหนางาน 

ศูนยการเรียนรูดวยตนเอง 

 

ผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

รองผูอำนวยการ 

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 
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3) โครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา สำนักวิทย

บริการและเทคโนโลยีสารสนเทศ (Activity chart) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

ภาพท่ี 2-3 แสดงโครงสรางการปฏิบัติงานกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา  

                           สำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

นายธนาวุฒิ  นิลมณี 

ผูอำนวยการสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหนากลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 

นายนพชัย ทิพยไกรลาศ 

นักวิชาการโสตทัศนศึกษาชำนาญการพิเศษ 

หัวหนางานงานผลิตสื่อโสตทัศน 

นายกฤษณ จำนงนิตย 

นักวิชาการโสตทัศศึกษาปฎิบัติการ 

หัวหนางานงานวิจัยและพัฒนาสื่อการศึกษา 

นายปฐมพงศ จำนงคลาภ 

นักวิชาการโสตทัศนศึกษาชำนาญการ 

  นางสาวปญญาพร แสงสมพร   นักวิชาการโสตทัศนศึกษา 

  นายศักด์ิเทพ จำนงคลาภ      นักวิชาการโสตทัศนศึกษา 

นายกิตติ แยมวิชา  นักวิชาการโสตทัศนศึกษาปฏิบัติการ 

*น.ส.ดลวรรณ สุทธิวัฒนกำจร นักวิชาการชางศิลปปฏิบัติการ 

น.ส.มัณฑนา ตุลยนิษกะ นักวิชาการชางศิลปปฏิบัติการ 

นายอุเทน พรหมมิ  นักวิชาการโสตทัศนศึกษาปฏิบัติการ 

นางสาวจุติมา พูลสวัสด์ิ นักวิชาการชางศิลปปฏิบัติการ 

นายนรินทร จิตตม่ันการ นักวิชาการชางศิลปปฏิบัติการ 

นายกุลภัทร พลายพลอยรัตน ชางศิลป 

นายปยะนนท ศุภจริยวิชัย นักวิชาการโสตทัศนศึกษา 

นายพรรษชล นาคฉ่ำ  นักวิชาการคอมพิวเตอร 

นายครรชิต จิตตานุวัฒน  นักวิชาการคอมพิวเตอรปฏิบัติการ 

    



8 
 

2.1.2 ภาระหนาท่ีของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ 

 สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มีภารกิจมุงเนนพัฒนามหาวิทยาลัยเทคโนโลยีราชมงคล

พระนคร ใหเปนสังคมแหงการเรียนรู (Learning Society) โดยใช ICT เปนฐานในการบริการการศึกษาไดอยาง

เต็มศักยภาพ มีจริยธรรมและมีสมรรถนะทาง ICT ตามมาตรฐานสากล สำนักวิทยบริการและเทคโนโลยี

สารสนเทศ มีภาระหนาที่ แบงตามงาน 1 งาน และกลุม 4 กลุม ประกอบดวย สำนักงานผูอำนวยการ กลุม

เทคโนโลยีสารสนเทศ กลุมเครือขายคอมพิวเตอรและการสื่อสาร กลุมวิทยบริการ และกลุมพัฒนานวัตกรรม

และเทคโนโลยีการศึกษา 

2.1.2.1 สำนักงานผูอำนวยการ 

งานบริหารทั่วไป มีหนาที่รับผิดชอบหลัก ดังน้ี  

1) งานธุรการและสารบรรณ 

2) งานบัญชีการเงิน 

3) งานบุคลากร 

4) งานนโยบายและแผน 

5) งานพัสดุและอาคารสถานที่ 

6) งานฝกอบรม 

7) งานสถิติและประเมินผล 

8) งานประชาสัมพันธ 

9) งานประกันคุณภาพ 

2.1.2.2 กลุมเทคโนโลยีสารสนเทศ มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวางแผนและพัฒนาระบบสารสนเทศเพื่องานการบริหารจัดการภายใน 

                        มหาวิทยาลัยฯ 

2) งานดูแลเคร่ืองคอมพิวเตอรแมขาย (server)  

3) งานติดต้ังและพัฒนาระบบสารสนเทศเพื่อการบริหารงานภายในมหาวิทยาลัยฯ 

4) งานกำหนดมาตรฐานดานเทคโนโลยีสารสนเทศ 

5) งานดูแลระบบสารสนเทศเพื่อการบริหาร 

6) งานดูแลลิขสิทธิ์ซอฟตแวรในมหาวิทยาลัยฯ 

7) งานบริการระบบสารสนเทศเพื่อการจัดการ 

8) งานระบบประกันคุณภาพ 

9) งานพัฒนาศูนยปฏิบัติการเพื่อการตัดสินใจเชิงการตัดสินใจเชิงกลยุทธ 

10) ใหคำปรึกษาดานเทคโนโลยีสารสนเทศแกหนวยงานตาง ๆ ภายในมหาวิทยาลัย 

2.1.2.3 กลุมเครือขายคอมพิวเตอรและการสื่อสาร มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวางแผนและพัฒนาระบบเครือขายหลักของมหาวิทยาลัยและการเชื่อมโยง 



9 
 

                        เครือขายภายในมหาวิทยาลัย 

2) งานดูแลเครือขายคอมพิวเตอรหลัก 

3) งานดูแลเคร่ืองคอมพิวเตอรแมขายดานเครือขาย 

4) งานดูแลเว็บไซตของมหาวิทยาลัยดานเทคนิค  

5) งานใหบริการระบบเครือขายภายในมหาวิทยาลัย 

6) ใหคำปรึกษาการใชงานระบบเครือขายแกหนวยงานภายในมหาวิทยาลัย 

7) งานดูแลและใหบริการศูนยการเรียนรูดวยตนเองทั้ง 4 แหง ไดแก  

     ศูนยการเรียนรูดวยตนเองเทเวศร  

     ศูนยการเรียนรูดวยตนเองพระนครเหนือ   

     ศูนยการเรียนรูดวยตนเองพณิชยการพระนคร  

     ศูนยการเรียนรูดวยตนเองโชติเวช  

2.1.2.4 กลุมวิทยบริการ มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานพัฒนาทรัพยากรสารสนเทศ 

2) งานวิเคราะหทรัพยากรสารสนเทศ 

3) งานวารสารและเอกสาร 

4) งานเตรียมทรัพยากรสารสนเทศ 

5) งานเทคโนโลยีสารนิเทศ 

6) งานใหบริการสารสนเทศและหองสมุด 4 แหง ไดแก 

     งานหองสมุดเทเวศร 

     งานหองสมุดโชติเวช 

     งานหองสมุดพณิชยการพระนคร 

     งานหองสมุดพระนครเหนือ 

2.1.2.5 กลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา มีหนาที่รับผิดชอบหลัก ดังน้ี 

1) งานวิจัยและพัฒนาสื่อการศึกษา 

2) งานผลิตสื่อโสตทัศน 

3) งานผลิตสื่อคอมพิวเตอร 

4) งานบริการทรัพยากรสื่ออิเล็กทรอนิกส 
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2.2 บทบาทหนาที่ความรับผิดชอบ 

2.2.1 หนาท่ีความรับผิดชอบของตำแหนงตามมาตรฐานกำหนดตำแหนง 

ปฏิบัติงานในฐานนะผูปฏิบัติงานที่มีความเชี่ยวชาญในงานดานวิชาการชางศิลป โดยใชความรู 

ความสามารถ ความเชี่ยวชาญ และประสบการณสูง ปฏิบัติงานเชิงพัฒนาระบบหรือมาตรฐานของ

งานหรืองานพัฒนาทฤษฎี หลักการ ความรูใหม ปฏิบัติงานวิจัยดานวิชาการชางศิลป และนำมา

ประยุกตใชในทางปฏิบัติ เพื่อใหการดำเนินงานตามแผนงานโครงการสำเร็จตามเปาหมายและ

วัตถุประสงค ตลอดจนเสนอแนะและประเมินผลแผนงานโครงการและแกไขปญหาในงานที่มีความ

ยุงยากและมีขอบเขตกวางขวางมากหรือถายทอดความรูเกี่ยวกับงานตลอดจนใหคำปรึกษา แนะนำ 

หรือปรับปรุงผสมผสานเทคนิคระดับสูงระหวางสาขาที่เกี ่ยวของ และปฏิบัติหนาที่อื ่นตามที่ไดรับ

มอบหมาย หรือ 

ปฏิบัติงานในฐานะหัวหนาหนวยงาน มีหนาที่และความรับผิดชอบในการควบคุม กำกับ

หนวยงานดานวิชาการชางศิลปที ่มีขอบเขตเน้ือหาของงานหลากหลายและมีขั ้นตอนการทำงานที่

ยุงยากซับซอนมากเปนพิเศษ ตลอดจนกำกับ ตรวจสอบผูปฏิบัติงานเพื่อใหงานที่รับผิดชอบสำเร็จตาม

วัตถุประสงค และปฏิบัติหนาที่อ่ืนตามที่ไดรับมอบหมาย 

         โดยมีลักษณะงานที่ปฏิบัติในดานตาง ๆ ดังน้ี 

 1. ดานการปฏิบัติการ 

(1) ปฏิบัติหนาที่ในฐานะผูเชี ่ยวชาญดานวิชาการชางศิลป พัฒนาและประยุกตใชความรู 

ความสามารถ ความเชี่ยวชาญ ประสบการณ วิธีการและเทคนิคตาง ๆ เพื่อพัฒนาระบบและมาตรฐาน

ในการปฏิบัติงาน 

(2) เปนผูคิดริเริ ่มการดำเนินการวิจัยตาง ๆ  ในงานวิชาการชางศิลป และเผยแพรผลงานที่

กอใหเกิดความรูใหมหรือเทคนิควิธีการใหมที่เปนประโยชนตองานวิชาการชางศิลปวางหลักเกณฑใน

การวิเคราะห วิจัย ประเมินผล รวมทั้งกำหนดวิธีการและระเบียบปฏิบัติทางดานวิชาการชางศิลป เพื่อ

พัฒนาระบบหรือมาตรฐานในการปฏิบัติงานวิชาการชางศิลป เสนอความเห็นเกี่ยวกับปญหาและ    

หาวิธีการแกไขปญหาที่มีความยุงยากและมีขอบเขตกวางขวางมากทางดานวิชาการชางศิลป ติดตาม

ความกาวหนาทางวิชาการดานวิชาการชางศิลปและดานที่เกี่ยวของ เพื่อนำมาประยุกตใชใหเหมาะสม

กับลักษณะงานของหนวยงานและเปนที่ปรึกษาในโครงการวิจัยทางดานวิชาการชางศิลป เพื่อให

คำแนะนำและขอเสนอแนะในการดำเนินการ 

(3) ใหบริการวิชาการดานตาง ๆ  เชน ฝกอบรม ใหการบริการและเผยแพรความรูทางดาน

วิชาการชางศิลป ตอบปญหาและชี้แจงเร่ืองตาง ๆ เกี่ยวกับงานในหนาที่ เพื่อใหสามารถปฏิบัติงานได

อยางถูกตอง มีประสิทธิภาพ เขารวมประชุมคณะกรรมการตาง ๆ ตามที่ไดรับแตงต้ัง เปนผูแทนของ

สถาบันอุดมศึกษาหรือของรัฐบาลในการเขารวมประชุมหรือเจรจาปญหาตาง ๆ เกี่ยวกับงานวิชาการ
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ชางศิลปทั ้งในและตางประเทศ เพื่อใหขอมูลทางวิชาการประกอบการพิจารณาและตัดสินใจ และ

ปฏิบัติหนาที่อ่ืนที่เกี่ยวของ 

(4) ในฐานะหัวหนาหนวยงาน นอกจากอาจปฏิบัติงานตามขอ (1)-(3) ดังกลาวขางตนแลว 

ตองทำหนาที่กำหนดนโยบายการปฏิบัติงาน ติดตอประสานงาน วางแผน มอบหมาย สงเสริม กำกับ 

ควบคุม ดูแล และตรวจสอบ ใหคำปรึกษา แนะนำ ปรับปรุงแกไข ติดตามประเมินผล และแกไข

ปญหาขอขัดของในการปฏิบัติงานในหนวยงานที่รับผิดชอบ เพื่อใหการปฏิบัติงานบรรลุตามเปาหมาย

และผลสัมฤทธิ์ที่กำหนด 

2. ดานการวางแผน 

รวมกำหนดนโยบายและแผนงานหรือโครงการของหนวยงานที่สังกัด วางแผนหรือรวมวาง

แผนการทำงานโดยเชื่อมโยงหรือบูรณาการแผนงานโครงการในระดับกลยุทธของสถาบันอุดมศึกษา

มอบหมายงาน แกไขปญหาในการปฏิบัติงาน ติดตามและประเมินผล เพื่อใหบรรลุตามเปาหมายและ

ผลสัมฤทธิ์ที่กำหนด 

3. ดานการประสานงาน 

(1) ประสานการทำงานโครงการตาง ๆ กับบุคคล หนวยงาน หรือองคกรอ่ืน โดยมีบทบาทใน

การจูงใจ โนมนาว เพื่อใหเกิดความรวมมือและผลสัมฤทธิ์ตามที่กำหนด 

(2) ใหขอคิดเห็นและคำแนะนำแกหนวยงานในสถาบันอุดมศึกษา รวมทั้งที่ประชุมทั้งในและ

ตางประเทศ เพือ่เปนประโยชนและเกิดความรวมมือในการดำเนินงานรวมกัน 

4. ดานการบริการ 

 (1) ใหคำปรึกษา แนะนำ วินิจฉัย ชี้แจง และตอบปญหาที่สำคัญหรือยุงยากซับซอนมาก 

เพื่อสรางความรูความเขาใจเกี่ยวกับงานวิชาการชางศิลป ใหบุคคลหรือหนวยงานสามารถดำเนินงาน

ไดลุลวงเปนไปตามนโยบายและแผนงานที่กำหนดไว หรือเพื่อเปนขอมูลประกอบการตัดสินใจและ

สนับสนุนภารกิจของหนวยงาน 

 (2) เผยแพร ถายทอดความรู ดานวิชาการชางศิลป เพื่อใหบุคคลทั่วไปไดรับความรูความ

เขาใจที่ถูกตองและเปนประโยชน 

2.2.2 บทบาทหนาท่ีความรับผิดชอบตามท่ีไดรับมอบหมาย    

        บทบาทหนาที่ความรับผิดชอบของนางสาวดลวรรณ สุทธิวัฒนกำจร ตำแหนงนักวิชาการชาง

ศิลป ระดับปฏิบัติการ ตามที่ไดรับมอบหมาย มีดังน้ี 

1. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อการเรียนการสอนทางไกลผานดาวเทียม 
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2. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อการเรียนการสอน Mooc 

3. จัดทำสคริปตและสตอร่ีบอรดทำหรับงานผลิตสื่อการเรียนการสอน Mooc 

4. ผลิตภาพกราฟกเร่ิมตนรายการ จบรายการ กราฟกแถบชื่ออาจารยผูสอน กราฟกแถบชื่อ

รายการ สำหรับงานสื่อวิดีทัศน 

5. ผลิตภาพกราฟกสำหรับเว็บไซตการเรียนการสอนผานระบบ LMS 

6. ผลิตภาพกราฟกสำหรับการถายทอดสัญญาณภาพและเสียงออกอากาศผานทางระบบ

อินเทอรเน็ต 

7. ผลิตภาพกราฟกสำหรับสื่อสิ่งพิมพ 

8. ผลิตภาพกราฟกสำหรับการประชาสัมพันธกิจกรรมมหาวิทยาลัยผานทางสื่อส ั งคม

ออนไลน 

9. ผลิตภาพกราฟกปกหนา ปกหลังและกลองใสแผนดีวีด ีสำหรับสื ่อการเรียนการสอน

ทางไกลผานดาวเทียมและสื่อวิดีทัศน 

10. จัดทำฉากและอุปกรณประกอบฉาก สำหรับการถายทำการถวายพระพรเน่ืองในวันคลาย

วันเฉลิมพระชนมพรรษาฯ 

11. ตรวจสอบ ดูแล บำรุงรักษา ซอมแซมอุปกรณที่ใชในการผลิตสื่อและฉากและอุปกรณ

ประกอบฉาก 

12. บำรุงรักษาครุภัณฑในสวนที่รับผิดชอบ 

13. รวมกำหนดนโยบายและแผนงานของหนวยงาน 

14. รวมจัดทำแผนการปฏิบัติงานประจำป 

15. จัดทำการประกันคุณภาพการศึกษา 

16. ประสานกับหนวยงานตาง ๆ ที่เกี่ยวของ 

17. ปฏิบัติงานอ่ืน ๆ ตามที่ไดรับมอบหมาย 
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จากภาระหนาที่ที่ไดรับมอบหมายดังกลาวขางตน ผูเขียนมีความสนใจในกระบวนการผลิตภาพกราฟก

สำหรับการถายทอดสัญญาณภาพและเสียงออกอากาศผานทางระบบอินเทอรเน็ต จึงนำมาเขียนคูมือการ

ปฏิบัติงาน โดยมีแผนผังขั้นตอนการปฏิบัติงานดังน้ี 

 

 

  

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

  

 

 

 

 
 

 

 

 

  

 

 

 

ภาพท่ี 2-4 แสดงแผนผังขั้นตอนการปฏิบัติงานการผลิตภาพกราฟกสำหรับการถายทอดสัญญาณภาพและ      

               เสียงออกอากาศผานทางระบบอินเทอรเน็ต 

ไมถูกตอง 

 

ไมถูกตอง 

 

รวบรวมขอมูล 

 

ตรวจสอบขอมูล 

 

ผลิตภาพกราฟก 
 

ตรวจสอบความถูกตองของ

ภาพกราฟก 
 

เร่ิมตน 

นำภาพกราฟกไปใชในการถายทอดสด 
 

สิ้นสุด 

ถูกตอง 

 

ถูกตอง 
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บทที่ 3 

หลักเกณฑวิธีการปฏบิัติงาน 

ในการผลิตภาพกราฟกสิ่งแรกที่ตองคำนึงคือ ลักษณะของกิจกรรมและกลุมเปาหมายของผูชมที่จะ

เปนตัวกำหนดแนวทางของภาพกราฟก ไมวาจะเปนภาพพักหนาจอ กราฟกแถบชื่อตาง ๆ เน่ืองจากกิจกรรม

และกลุมเปาหมายที่แตกตางกัน ภาพที่ตองการนำเสนอจึงแตกตางกันออกไป  

 กิจกรรมที่เปนพิธีการ เชน กิจกรรมวันไหวครู กิจกรรมพิธีซอมรับปริญญา ตัวอักษรควรมีลักษณะที่

เรียบงาย รูปภาพลักษณะเปนทางการ ควรใชสีโทนออนหรือเขม ไมควรเปนสีที่มีลักษณะฉูดฉาด จะทำใหดูไม

สบายตาและไมเปนที่นาเชื่อถือ 

 กิจกรรมที่เปนกึ่งพิธีการ เชน กิจกรรมวันปฐมนิเทศ เนื่องจากกิจกรรมวันปฐมนิเทศในชวงเชา 

ผูบริหารมหาวิทยาลัยจะใหคำแนะนำแกนักศึกษา ไมวาจะเปนการลงทะเบียนเรียน การเขาเรียน การเขารวม

กิจกรรมของมหาวิทยาลัย เปนตน ในชวงบายเปนกิจกรรมสันทนาการของรุนพี่และรุนนอง เพราะฉะน้ัน

รูปแบบของภาพกราฟกจึงตองนำเสนอในรูปแบบกึ่งทางการ  โดยการใชตัวอักษรที่เรียบงาย สีไมฉูดฉาด 

รูปภาพที่นำเสนอจะเปนรูปภาพที่มีลักษณะไมเปนทางการ ทำใหดูสบายตาแตไมนาเบื่อ 

 กิจกรรมที่ไมเปนทางการ เชน กิจกรรมการประกวด Miss RMUTP Award สามารถใชตัวอักษรที่มี

ลูกเลน มีสไตล สีที่ใชควรจะมีสีสันที่สดใส ภาพที่ใชเปนภาพที่มีชีวิตชีวา เพื่อดึงดูดความสนใจของผูชม 

ในการปฏิบัติงานคูมือเรื ่อง การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต โดยใช

โปรแกรม Adobe Photoshop cc น้ัน มีทฤษฏีที่เกี่ยวของดังน้ี 

  3.1    องคประกอบศิลป 

  3.2    หลักการออกแบบ 

3.3    คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc 

3.4    สวนประกอบในหนาตางของในโปรแกรม Adobe photoshop cc 

3.5    คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc 
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3.1    องคประกอบศิลป 

3.1.1   จุด  

จุด คือ ลักษณะกลม ๆ เล็ก ๆ ไมมคีวามกวาง ความยาว ความหนา ความลึก เปนองคประกอบ

ที่เล็กที่สุด ใหความรูสึกหยุดนิ่ง ไมเคลื่อนไหว เมื่อนำจุดมาวางเรียงกันจะเกิดเปนเสนหรือรูปราง 

รูปทรงตาง ๆ ได 

3.1.2 เสน  

เสน คือ จุดหลาย ๆ จุดเรียงตอกันใหเกิดความยาวไปในทิศทางใดทิศทางหนึ่ง เสนที่เปน

พื้นฐานจะมีอยูสองชนิด คือเสนตรงและเสนโคง เสน เปนองคประกอบพื ้นฐานที่สำคัญในการ

ออกแบบ สามารถแสดงใหเกิดความรูสึกไดตามลักษณะของเสน เชน  

เสนนอน ใหความรูสึกกวางขวาง สงบ น่ิง ราบเรียบ 

เสนต้ัง ใหความรูสึกมั่นคง แข็งแรง สงางาม 

เสนเฉียง ใหความรูสึกเคลื่อนไหว ไมมั่นคง 

เสนโคง ใหความรูสึกออนโยน นุมนวล 

เสนคลื่น ใหความรูสึกเคลื่อนไหว ราเริง ตอเน่ือง 

เสนซิกแซกหรือเสนฟนปลา ใหความรูสึกขัดแยง ต่ืนเตน 

เสนประ ใหความรูสึกไมตอเน่ือง ไมมั่นคง ไมแนนอน 

3.1.3 รูปรางและรูปทรง  

โดยปกติแลวรูปรางและรูปทรงจะมีลักษณะคลาย ๆ  กัน แตกตางกันที่มิติ คือ รูปรางจะมี

ลักษณะเปน 2 มิติ มีความกวางและความยาว สวนรูปทรงจะมีลักษณะเปน 3 มิติ มีความกวาง ความ

ยาวและความลึกเพิ่มเขามา โดยรูปรางและรูปทรงสามารถแบงออกไดเปน 3 ประเภท คือ 

รูปรางและรูปทรงธรรมชาติ คือ รูปรางหรือรูปทรงที่เลียนแบบมาจากธรรมชาติ 

อาจจะเหมือนหรือคลายกับของจริง เชน คน สัตว ใบไม กอนเมฆ ภูเขา เปนตน 

รูปรางและรูปทรงเรขาคณิต คือ รูปรางหรือรูปทรงที่สรางขึ้นโดยเคร่ืองมือเรขาคณิต 

เชน วงเวียน ไมบรรทัด ไมฉาก หรือไมไดสรางขึ้นโดยเคร่ืองมือเรขาคณิต แตมีลักษณะเปน

รูปเรขาคณิต เชน วงกลม วงรี สามเหลี่ยม สี่เหลี่ยม เปนตน มีลักษณะที่แนนอน ตายตัว 
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รูปรางและรูปทรงอิสระ คือ รูปรางหรือรูปทรงที่มีลักษณะที่ไมแนนอน เคลื่อนไหว

อิสระตามแตผูสรางสรรค มีลักษณะที่ตรงขามกับรูปทรงเรขาคณิต 

3.1.4 ท่ีวาง  

ที่วาง คือ บริเวณที่ไมมีองคประกอบใด ๆ อยูรอบบริเวณน้ัน หรือพื้นที่ที่ลอมรอบรูปรางกับ

รูปทรง หรือพื้นที่ระหวางรูปรางกับรูปทรง หรือพื้นที่ภายในรูปทรง เปนตน ที่วางสามารถสราง

ความรูสึกได เชน ถามีที่วางนอยเกินไป จะทำใหเกิดความรูสึกอึดอัด คับแคบ แนน แตถามีที่วางมาก

เกินไป จะทำใหเกิดความรูสึกโลง โปรง สบายตา เปนตน ชลูด น่ิมเสมอ (2553 : 92-93) แบงที่วาง

เปน 6 ประเภท คือ 

1) ที่วางจริงและที่วางลวงตา ที่วางจริง คือ ที่วางที่สามารถรับรูสัมผัสไดในทางกายภาพ 

เชน งานประติมากรรม งานสถาปตยกรรม เปนตน เปนที่วางทางกายภาพ สวนที่

วางลวงตา เปนพื้นที่วางที่เกิดจากการสรางสรรคความกวาง ความยาวและความลึก 

ใหเกิดภาพ 3 มิติ เปนที่วางที่เกิดจากความรูสึก ไมสามารถสัมผัสไดจริง เชน ภาพ

จิตรกรรม ภาพพิมพ เปนตน  

2) ที่วางแบบ 2 มิติ คือ พื้นที่วางที่มีแคความกวางกับความยาว เปนพื้นที่วางของพื้นผิว

ที่แบนราบ เชน พื้นที่วางบนกระดาษ ผนัง เปนตน 

3) ที่วางแบบ 3 มิติ คือ พื้นที่วางที่มีความกวาง ความยาวและความลึก เปนที่วางที่มี

ปริมาตร เชน ที่วางในหอง ที่วางของรูปทรง 3 มิติ หรือที่วางในงานจิตรกรรมที่ทำ

ใหเกิดภาพลวงตาเปน 3 มิติ เปนตน 

4) ที่วางที่เปนกลาง เปนพื้นที่ที ่วางเปลา ยังไมไดกำหนดขอบเขต รูปรางลงไป เชน 

พื้นที่วางของกระดาษ ผนัง เปนตน 

5) ที่วางบวกและที่วางลบ ที่วางบวก คือ พื้นที่ที่อยูภายในรูปราง รูปทรงที่สรางขึ้น ถือ

วาเปนที่วางที่มีพลัง มีความหมาย สวนที่วางลบจะตรงขามกับที่วางบวก คือพื้นที่ที่

อยูภายนอกรูปราง รูปทรงที่สรางขึ้น  

6) ที่วาง 2 นัย คือ พื้นที่วางที่ถูกกำหนดใหความสำคัญเทาเทียมกัน ไมสามารถกำหนด

ไดวาบริเวณไหนคือที่วางบวก บริเวณไหนคือที่วางลบ 

3.1.5 พ้ืนผิว  

พื้นผิว คือ ลักษณะของผิวที่ปรากฏอยูสวนนอกสุดของวัตถุ มีลักษณะที่แตกตางกันออกไป 

รับรูไดดวยการรับสัมผัสทางกายและทางสายตา พื้นผิวสามารถกอใหเกิดความรูสึกในลักษณะตาง ๆ 

ได เชน หยาบ ละเอียด เรียบ ดาน ขรุขระ เปนตน แบงเปน 2 ลักษณะ คือ  
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พื้นผิวที่รับรูไดดวยการสัมผัส เปนพื้นผิวจริง ๆ ของวัตถุน้ัน ๆ เชน พื้นผิวของกระดาษทราย 

เปลือกไม แกว กระเบื้อง เปนตน 

พื้นผิวที่รับรูไดดวยตา คือ เปนลักษณะผิวที่ทำเทียมขึ้นเปนการลวงตา เชน กระเบื้องที่เปน

ลายไม มีลักษณะขรุขระ แตพอสัมผัสกลับมีลักษณะที่เรียบเนียน เปนตน 

3.1.6 แสงและเงา  

แสงและเงา คือ ความแตกตางของน้ำหนักสีบนผิววัตถุ เกิดจากวัตถุไดรับแสงไมเทากัน สวน

ที่ไมโดนแสงจึงเกิดเปนเงาขึ้น ทำใหเห็นน้ำหนักของสีที่แตกตางกัน การใชแสงและเงาจะทำใหเกิดมิติ 

เชน มีความลึกตื้นของผลงาน เกิดระยะใกลไกล เปนตน แสงและเงาที่เกิดบนวัตถุ แบงไดเปน 6 

ระดับ คือ 

บริเวณที่สวางที่สุด คือ บริเวณที่ถูกแสงมากที่สุด จนเกิดการสะทอน ทำใหสีที่เห็นมี

น้ำหนักนอยกวาสีจริงของผิววัตถุ มักเกิดบนวัตถุที่มีผิวเรียบ 

บริเวณสวาง คือ บริเวณที่วัตถุไดรับแสงแตไมเกิดการสะทอน 

บริเวณเงา คือ บริเวณที่วัตุไดรับแสงเพียงเล็กนอย 

บริเวณเงามืด คือ เปนบริเวณที่แสงไมสามารถสองผานไดและไดรับผลกระทบจาก

แสงสะทอนนอยที่สุด จึงเปนบริเวณที่มืดที่สุด สีบริเวณน้ีจึงมีคาน้ำหนักเขมสุด 

บริเวณแสงสะทอน คือ เปนบริเวณที่ไมไดโดนแสงโดยตรง แตไดรับแสงสะทอนจาก

วัตถุอื ่นที่อยูใกล ๆ  กัน น้ำหนักสีบริเวณนี้จึงนอยกวาบริเวณเงามืดแตเขมกวาบริเวณแสง

สวาง 

บริเวณเงาตกทอด คือ เปนบริเวณที่เงาของวัตถุนั ้น ตกทอดไปยังวัตถุอื ่น มีคา

น้ำหนักสีออนเขมไมเทากัน บริเวณที่ใกลวัตถุจะมีน้ำหนักเขมมากกวาบริเวณอ่ืน  

3.1.7 สี   

สี เป นส วนประกอบของศิลปะที ่ม ีความสำคัญ และมีบทบาทที ่ค อนข างโดดเดนกวา

องคประกอบอ่ืน ๆ สามารถสรางความนาสนใจใหกับงานออกแบบ การใชสีอยางเหมาะสมจะชวยให

ผลงานในภาพรวมออกมามีความสวยงาม ชวยใหสารที่จะสื่อมีความเขาใจงายมากขึ้น นอกจากน้ีสียังมี

อิทธิพลตอจิตใจมนุษยเปนอยางมาก มีพลัง สามารถสรางปฏิกิริยากับอารมณ ความรูสึกของผูชมให

เปนไปตามที่นักออกแบบตองการ 
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1) คุณลักษณะของสี 

เน้ือสี (hue) คือ สีที่แสดงถึงความแตกตางวาเปนสีอะไร เชน สีแดง สีเหลือง สีน้ำเงิน เปนตน 

เปนสีแทที่อยูในธรรมชาติ ไมถูกผสมโดยสีใด ๆ แบงเปน 2 ประเภท คือ 

สีของแสง เกิดจากคลื่นความถี่ของแสงที่มนุษยสามารถมองเห็น เปนสีมีที ่มีอยูใน

แสงธรรมชาติ เชน สีของรุงกินน้ำ สีของทองฟาในชวงเวลาตาง ๆ เปนตน 

สีของสาร เปนสีที่มองเห็นบนวัตถุตาง ๆ ที่เกิดขึ้นโดยธรรมชาติ เชน สีดำของถาน สี

เหลืองของฟกทอง สีน้ำเงินของดอกอัญชัน สีของแรธาตุตาง ๆ เปนตน สีหรือเกิดจาก

กระบวนการทางเคมี เชน สีน้ำ สีโปสเตอร สีน้ำมัน เปนตน  

น้ำหนักสี (value) คือ คาความออนหรือความเขมของสี เร่ิมจากสวนที่ออนที่สุดจนเกือบขาว 

ไปจนถึงสีที่เขมที่สุดจนเกือบดำ สามารถเปลี่ยนแปลงไดโดยการเติมสีลงไป แบงออกเปน 3 ประเภท 

คือ  

Tint เปนการเติมสีขาวลงไปในสีแท ทำใหไดคาน้ำหนักสีที่ออนลง 

Tone เปนการเติมสีเทาลงไปในสีแท ทำใหไดคาน้ำหนักสีกลางหรือจาง 

Shade เปนการเติมสีดำลงไปในสีแท ทำใหไดคาน้ำหนักสีที่เขมขึ้น 

ความเขมของสี (intensity) คือ ความสดหรือความอ่ิมตัวของสี สีแทแตละสีจะมีคาความเขม

ของสีที่มากที่สุด เน่ืองจากยังไมไดถูกผสมกับสีใด ความสดของสีสามารถเปลี่ยนแปลงไดโดยการนำสี

แทมาผสมกับสีตาง ๆ เชน สีขาว สีดำ หรือสีคูตรงขาม ทำใหความสดของสีลดลง  

2) วงจรสี  

สีที ่นำมาใชในการสรางสรรคงานตาง ๆ  นั้น เปนสีที ่เกิดจากเนื้อสี เรียกวาสีวัตถุธาตุ ซึ่ง

สามารถแสดงความสัมพันธไดเปนวงสี (ฉัตรชัย อรรถปกษ, 2548 : 74) โดยวงสีจะแบงออกเปน 3 ขั้น 

คือ 

วงสีขั้นที่ 1 เรียกวาแมสี มี 3 สีพื้นฐาน คือ คือ สีแดง สีเหลือง สีน้ำเงิน เปนสีที่ไม

สามารถผสมขึ้นมาเองได 

วงสีขั้นที่ 2 เกิดจากการจับคูผสมกันของแมสีขั้นพื้นฐาน 2 สี ในอัตราสวนที่เทา ๆ 

กัน ทำใหเกิดสีใหม 3 สี  
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    แมสี    + แมสี    =      สีขั้นที่สอง 

         สีเหลือง    + สีน้ำเงิน    =      สีเขียว 

          สีเหลือง    + สีแดง    =      สีสม 

           สีแดง    + สีน้ำเงิน    =      สีมวง 

วงสีขั ้นที่ 3 เกิดจากการจับคูผสมกันของแมสีขั้นที่ 1 กับสีขั ้นที่ 2 ในอัตราสวนที่

เทากัน ทำใหเกิดสีใหมอีก 6 สี คือ สีเขียวน้ำเงิน สีเขียวเหลือง สีมวงน้ำเงิน สีมวงแดง สีสม

แดง สีสมเหลือง 

แมสี    + แมสี    =      สีขั้นที่สอง 

    สีน้ำเงิน    + สีเขียว    = สีน้ำเงินเขียว 

    สีน้ำเงิน    + สีมวง    = สีน้ำเงินมวง 

สีแดง    + สีสม    = สีแดงสม 

    สีแดง    + สีมวง    = สีแดงมวง 

    สีเหลือง    + สีสม    = สีเหลืองสม 

    สีเหลือง    + สีเขียว    = สีเหลืองเขียว 

หากนำแมสีทั ้งสามสีมาผสมกันในอัตราสวนที่เทากัน และสีที่นำมาผสมมีความ

เขมขนสูง จะเกิดเปนสีดำ ถาความเขมขนต่ำลงมาก็จะเปนสีเทา ในทางศิลปะเรียกสองสีน้ีวา 

สีกลาง 

จากแมสีสามสี สีขั้นที่สอง และสีขั้นที่สาม เมื่อรวมกันแลวจะไดสีทั้งหมด 12 ส ี

3) วรรณะสี 

วรรณะสี คือ กลุมสีที่ใหความรูสึกที่แตกตางกัน ถาแบงวงสีออกเปนสองซีก ซีกหน่ึงจะเปนสี

วรรณะรอน อีกซีกจะเปนสีวรรณะเย็น 

สีวรรณะรอน คือ สีที่ใหความรูสึกอบอุน รอนแรง ต่ืนเตน ราเริง มีสีแดงเปนหลัก สี

วรรณะรอนในวงสีมี 6 สี ประกอบไปดวย สีเหลือง สีเหลืองสม สีสม สีสมแดง สีแดง และสี

มวงแดง 
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สีวรรณะเย็น คือสีที่ใหความรูสึกอบอุน สบาย สงบ สดชื่น เรียบรอย มีสีน้ำเงินเปน

หลัก สีวรรณะเย็นในวงสีมี 6 สี ประกอบไปดวย สีมวง สีมวงน้ำเงิน สีน้ำเงิน สีน้ำเงินเขียว สี

เขียว และสีเขียวเหลือง 

สวนสีที่อยูไดทั้งวรรณะรอนและวรรณะเย็น คือสีมวงและสีเหลือง ถือเปนสีที่อยูใน

วรรณะกลาง ๆ ถาอยูในกลุมของสีรอนก็จะรอนไปดวย แตถาอยูในกลุมของสีเย็นก็จะเย็น 

4) สีกับความรูสึก 

   สีแดง ใหความรูสึกต่ืนเตน รุนแรง มีอำนาจ อันตราย 

   สีสม ใหความรูสึกอบอุน สดใส ราเริง คึกคะนอง ปลดปลอย 

   สีเหลือง ใหความรูสึกสดใส ราเริง เบิกบาน มีชีวิตชีวา 

   สีเขียว ใหความรูสึกผอนคลาย สงบ สันโดษ รมเย็น รมร่ืน ปลอดภัย 

   สีฟา ใหความรูสึกสงบ เยือกเย็น เปนอิสระ ปลอดภัย   

   สีน้ำเงิน ใหความรูสึกสุขุม หนักแนน สงางาม สูงศักด์ิ มีระเบียบ 

   สีมวง ใหความรูสึกมีเสนห ลึกลับ มีอำนาจ ความผิดหวัง  ความเศรา 

   สีชมพู ใหความรูสึกนารัก ใจกวาง อบอุน ออนเยาว ทะนุถนอม 

   สีน้ำตาล ใหความรูสึกมั่นคง เปนมิตร จริงใจ แข็งแรง แหงแลง ทรุดโทรม  

   สีเทา ใหความรูสึกมีระเบียบ สุภาพ สงบ เงียบ เศรา หดหู   

   สีดำ ใหความรูสึกพลังอำนาจ ลึกลับ นาเกรงขาม ความทุกข ลึกลับ  

   สีขาว ใหความรูสึกบริสุทธิ์ สันติภาพ เรียบงาย สะอาด วางเปลา  
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3.2    หลักการออกแบบ 

หลักการออกแบบคือ การนำองคประกอบศิลป มาจัดวางเพื่อใหเกิดความสวยงามและตรงตาม

วัตถุประสงคที่ตองการ มีหลักการดังน้ี 

3.2.1 ความสมดุล 

ความสมดุล คือ น้ำหนักที่เทากันของสิ่งตาง ๆ  เปนการกระจายน้ำหนักใหไมเอนเอียงไป

ทางดานในดานหน่ึง ความสมดุลในทางศิลปะน้ันเปนความสมดุลทางดานความรูสึก ซึ่งความสมดุลที่

เห็นอาจจะไมเทากัน แตสัมผัสไดดวยอารมณ ความรูสึกของคน แบงออกไดเปน 2 ประเภทคือ 

ความสมดุลแบบสองขางเทากัน หรือ ความสมดุลแบบสมมาตร คือ มีการจัดวางองคประกอบ

ตาง ๆ ที่เทากัน เหมือนกันทั้ง 2 ขาง ไมแตกตางกัน การจัดวางลักษณะน้ีใหความรูสึก มั่นคง สงางาม 

แข็งแรง นาเกรงขาม  

ความสมดุลแบบสองขางไม เท ากัน หรือความสมดุลแบบอสมมาตร คือการจัดวาง

องคประกอบที่ไมเหมือนกันทั้งสองดาน เชน มีขนาดและน้ำหนักไมเหมือนกัน สัดสวน ปริมาตรไม

เทากัน แตมองแลวใหความรูสึกที่เทากัน  

3.2.2 ความกลมกลืน 

ความกลมกลืน คือ การประสานกันขององคประกอบตาง ๆ เชน สี ขนาด รูปราง รูปทรง ที่

วาง ใหเปนอันหนึ่งอันเดียว ไมขัดแยงกัน เทียนชัย ตั้งพรประเสิรฐ (2549 : 57-58) แบงความ

กลมกลืนออกเปน 3 ลักษณะ คือ   

ความกลมกลืนจากสิ่งที่เหมือนกัน คือ ความกลมกลืนในการจัดองคประกอบดวยรูปรางหรือ

รูปทรงที่มีลักษณะซ้ำ ๆ กัน เชน ใชรูปทรงกลมเพียงอยางเดียว ทำใหดูนาเบื่อ ไมนาสนใจ 

ความกลมกลืนจากสิ่งที่คลายคลึงกัน คือ ความกลมกลืนจากการใชวัตถุ สิ่งของ ที่มีลักษณะ

ใกลเคียงมาจัดรวมกัน เชน การใชรูปวงกลมกับรูปวงรี จะไดผลนาสนใจขึ้น 

ความกลมกลืนจากสิ่งที่ตางกัน คือ ความกลมกลืนในการจัดองคประกอบดวยรูปรางรูปทรงที่

แตกตางกันหรือการขัดแยงดวยสี แตสามารถแสดงความกลมกลืนออกมาไดเปนอยางดี จะใหผลที่

นาสนใจ  

3.2.3 ความขัดแยง 

ความขัดแยง คือ ความแตกตางหรือความไมเขากันขององคประกอบตาง ๆ เชน สีตรงกันขาม 

รูปทรงที่แตกตางกัน ผิวหยาบกับผิวละเอียด เปนตน ความขัดแยงจะตรงกันขามกับความกลมกลืน 
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การใชความขัดแยงในงาน จะทำใหเกิดความนาสนใจมากยิ่งขึ้น ดูไมนาเบื่อ แตถามีความขัดแยงมาก

เกินไปจะทำใหขาดความสมดุล  ดังนั้นจึงตองใชความขัดแยงในปริมาณที่เหมาะสมจึงจะกอใหเกิด

ความสวยงาม 

3.2.4 การซ้ำ 

การซ้ำ คือ การนำองคประกอบที่มีลักษณะเหมือนกันมาใชมากกวา 1 คร้ังในการออกแบบ 

สามารถทำไดหลายวิธี เชน การซ้ำดวย เสน สี รูปราง รูปทรง น้ำหนัก ขนาด เปนตน หรือการซ้ำดวย 

ตำแหนง ทิศทาง ที่วาง เปนตน การซ้ำเปนการสรางสรรคงานที่งายที่สุด แตในขณะเดียวกันการซ้ำที่

เหมือนกัน อาจจะทำใหงานดูนาเบื่อ ไมมีความนาสนใจได 

3.2.5 จังหวะ 

จังหวะ คือ การซ้ำอยางเปนระเบียบ เปนการนำองคประกอบตางมาวางซ้ำ ๆ ตอเน่ืองกันไป 

โดยมีพื้นที่วางค่ันกลาง ซึ่งพื้นที่วางอาจจะเทากันหรือไมเทากันก็ได โดยพื้นที่วางจะเปนตัวกำหนด

ความถี่หางของจังหวะใหตอเนื่องกันหรือหยุดเปนชวง ๆ  จะทำใหเกิดความรูสึกตาง ๆ  ขึ ้นในงาน

ออกแบบ เชน เร็ว ชา ถี่ หาง เคลื่อนไหว หนักเบา เปนตน จังหวะแบงออกไดเปน 3 ประเภท คือ 

จังหวะซ้ำกัน คือ การนำองคประกอบที่เหมือนกัน ทั้งรูปราง รูปทรง น้ำหนัก สี เปน

ตน มาวางซ้ำกันต้ังแต 2 หนวยขึ้นไป โดยมีพื้นที่วางที่ค่ันกลางระหวางองคประกอบศิลปน้ัน 

จังหวะตอเน่ือง คือ การนำองคประกอบมาวางซ้ำ ๆ ใหเกิดการตอเน่ืองไปเร่ือย ๆ 

โดยไมมีพื้นที่วางมากั้นหรือกำหนดระยะ ทำใหเกิดความเคลื่อนไหวตอเน่ืองอยางสม่ำเสมอ  

ไมขาดระยะ เชน คลื่นในทะเล 

จังหวะกาวหนา คือ การนำองคประกอบมาจัดวางซ้ำ ๆ กัน โดยมีการเพิ่มขึ้นของ สี 

น้ำหนัก รูปราง รูปทรง พื้นผิว เปนตน ในองคประกอบน้ัน ๆ ทำใหในแตละระยะของการจัด

วางน้ันมีการเปลี่ยนแปลงไปเร่ือย ๆ  

3.2.6 การเนน 

การเนน คือ การทำใหบริเวณใดบริเวณหน่ึง มีความโดดเดน นาสนใจกวาองคประกอบอ่ืน ๆ 

เปนการบังคับสายตาใหมองมายังบริเวณที่ตองการ เพื่อกระตุนการรับรูของผูชม การเนนจะทำใหภาพ

มีเรื ่องราวที่นาสนใจมากขึ้น เทียนชัย ตั้งพรประเสริฐ (2549: 92-95) แบงการเนนออกเปน 4 

ลักษณะ ดังน้ี 

1) การเนนดวยการตัดกัน เปนการเนนที่ทำใหองคประกอบอ่ืน ๆ มีความขัดแยงกัน แบงได

เปนหลายลักษณะ คือ 
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การเนนดวยพื้นผิว เปนการใชลักษณะพื้นผิวที่แตกตางกัน เชน พื้นผิวหยาบกับ

พื้นผิวละเอียด เปนตน 

การเนนดวยขนาด เปนการเนนดวยรูปรางหรือรูปทรงที่มีขนาดไมเทากัน เชน 

วงกลมเล็ก และวงกลมใหญ เปนตน 

การเนนดวยสี เปนการใชสีที่ไมเหมือนกัน เชน สีออนกับสีเขม สีคูตรงขาม เปน

ตน 

การเนนดวยรูปทรง เปนการเนนดวยรูปทรงที่ไมเหมือนกัน เชน รูปทรงกลม

หน่ึงรูปกับรูปทรงสี่เหลี่ยมหลาย ๆ รูป หรือ รูปทรงเรขาคณิตกับรูปธรรมชาติ เปนตน 

การเนนดวยน้ำหนัก เปนการเนนดวยการใชน้ำหนักออนและน้ำหนักเขม เชน 

จุดสีขาวที่อยูบนพื้นสีดำ จุดสีขาวจะเดนขึ้น เปนตน 

2) การเนนโดยการแยกตัวออกไป เมื่อของสิ่งใดสิ่งหน่ึงถูกแยกออกมาจากกลุม ของสิ่งน้ัน

จะกลายเปนจุดเดนขึ้นมาทันที  

3) การเนนโดยการจัดวางตำแหนง เปนการใชองคประกอบนำสายตาใหมายังตำแหนงที่

ตองการเนนใหสนใจ แบงเปน 3 ลักษณะ คือ 

การจัดวางตำแหนงที่มีทิศทางคลอยตามกัน 

การจัดวางตำแหนงใหแพรเปนรัศมีจากจุดเดน 

การจัดวางตำแหนงโดยใชเสนนำสายตาไปยังสวนสำคัญของภาพ 

4) การไมปรากฏความเดนของจุดสนใจ คือ การไมเนนสิ่งใดสิ่งหน่ึงในภาพ ทุกสวนมีความ

โดดเดนเทาเทียมกันหมด เชน ลวดลายของเสื้อผา ลวดลายของเคร่ืองกระเบื้อง ลวดลาย

เคร่ืองประดับ เปนตน  

3.2.7 สัดสวน 

สัดสวน คือ ความสัมพันธกันอยางเหมาะสม ระหวางขนาดขององคประกอบตาง ๆ ที่มี

ลักษณะเหมือนกันและแตกตางกัน ใหความสัมพันธที่ไมมากไมนอยเกินไป มีความกลมกลืนกันของ

องคประกอบทั้งหลาย ประเสิรฐ พิชยะสุนทร (2555 : 128) แบงสัดสวนออกเปน 2 ลักษณะ ดังน้ี 

สัดสวนจากความรูสึก เปนสัดสวนที่สรางขึ้นเพื่อแสดงออกถึงอารมณความรูสึก ให

เปนไปตามที่ผูสรางผลงานตองการ อาจมีสัดสวนเหมือนจริงหรือบิดเบี้ยวผิดจากความเปน

จริงไปก็ได 
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สัดสวนที่เปนมาตรฐาน เปนสัดสวนจากลักษณะตามธรรมชาติของคน สัตว พืช เปน

ตน โดยทั่วไปถือวาสัดสวนตามธรรมชาติมีความงดงาม เหมาะสมที่สุด โดยสัดสวนที่ถือวามี

ความสวยงามที่สุด คือ สัดสวนทองคำ เปนการคำนวณหาสัดสวนที่สวยงามที่สุดในโลกโดย

วิธีการทางคณิตศาสตร คิดคนโดย ลีโอนาโด ฟโบนัชชี นักคณิตศาสตรชาวอิตาลี ยึดหลักที่วา 

สวนเล็กสัมพันธกับสวนที่ใหญกวา สวนที่ใหญกวาสัมพันธกับสวนรวม ทำใหทุกสิ่งที่สรางขึ้น

มีความสัมพันธกันอยางลงตัว มีอัตราสวนคือ 1:1.618 หรือ 2:3  

3.2.8 เอกภาพ 

เอกภาพ คือ ความเปนอันหน่ึงอันเดียวกัน หรือความเขากันได ที่เกิดจากการประสานกันของ

องคประกอบศิลป เชน จุด เสน รูปราง รูปทรง ลักษณะผิว สี เปนตน และนำองคประกอบศิลปเหลาน้ี

มาสรางสรรคใหงานมีความสมดุล ความขัดแยง ความกลมกลืน จนเกิดความเปนอันหน่ึงอันเดียวกัน 

สอดคลอง กลมกลืนกันทั้งงาน  

 

3.3    คุณสมบัติที่ควรรูของโปรแกรม Adobe Photoshop cc 

3.3.1 คุณสมบัติของเคร่ืองคอมพิวเตอรท่ีเหมาะกับ Adobe Photoshop cc 

Adobe Photoshop เปนโปรแกรมในตระกูล Adobe เหมาะสำหรับงานกราฟกทุกรูปแบบ 

เชน การตกแตงภาพ ออกแบบงานกราฟก สรางและแกไขรูปภาพ ใสเอฟเฟกตใหกับรูปภาพ หรือ

ตัวหนังสือ ทำภาพใหเปนขาวทำ ทำภาพถายใหเปนภาพเขียน เปนตน สามารถใชงานไดตั ้งแตมือ

อาชีพไปจนถึงมือสมัครเลน ไมวาจะเปนชางภาพ นักออกแบบกราฟก นักครีเอทีฟ นักออกแบบ

เว็บไซต หรือแมแตนักเรียน นักศึกษาที่ใชทำงาน ทำการบานสงอาจารย  

อนัน วาโซะ (2559 : 16) กำหนดคุณสมบัติเครื่องคอมพิวเตอรท ี ่ เหมาะกับการติดต้ัง

โปรแกรม Adobe Photoshop cc ดังน้ี  

  สำหรับ Windows จะตองมีคุณสมบัติ 

CPU: Intel Pentium 4 หรือ AMD 64 Processor (2GHz ขึ้นไป) 

ระบบปฏิบัติการ : Windows 7 Service Pack 1, Windows 8 หรือ 8.1 

หนวยความจำหลัก (RAM) : อยางต่ำ 1 GB 

พื้นที่วางบนฮารดดิส : อยางต่ำ 2.5 GB 

จอภาพ : ความละเอียดอยางต่ำ 1,028 x 768 Pixels หนวยความจำ 512 MB 

การดจอ : สนับสนุน OpenGL 2.0 16 bit 
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สำหรับ Mac OS จะตองมีคุณสมบัติ 

CPU: Multicore Intel Processor ที่สนับสนุน 16 bit 

ระบบปฏิบัติการ : Mac OS X v10.7 หรือ 10.8 หรือ 10.9 

หนวยความจำหลัก (RAM) : อยางต่ำ 1 GB 

พื้นที่วางบนฮารดดิส : อยางต่ำ 3.2 GB 

จอภาพ : ความละเอียดอยางต่ำ 1,028 x 768 Pixels หนวยความจำ 512 MB 

การดจอ : สนับสนุน OpenGL 2.0 16 bit 

3.3.2    ประเภทของภาพในงานคอมพิวเตอรกราฟก 

1) ความหมายของพิกเซล 

ภาพในคอมพิวเตอรเปนภาพแบบดิจิตัล เกิดจากจุดสี่เหลี่ยมเล็ก ๆ จำนวนมากเรียงตอ

กันจนทำใหเกิดภาพ จุดเล็ก ๆ น้ี เรียกกันวา พิกเซล (Pixel)  

 

 

 

 

 

 

พิกเซลเปนหนวยพื้นฐานของภาพ แตละพิกเซลจะมีคาสีเปนของตัวเองไมซ้ำกัน ภาพแตละ

ภาพจะมีความหนาแนนของพิกเซลที่แตกตางกัน ความหนาแนนน้ีเปนตัวบงบอกถึงความละเอียดของ

ภาพ มีหนวยเปน ppi (Pixel Per Inch) คือ จำนวนพิกเซลตอตารางน้ิว เชน ภาพที่มีความละเอียด 

300 ppi หมายถึง ใน 1 ตารางน้ิวของภาพ จะมีจำนวนจุดพิกเซลอยู 300 จุด ดังน้ันความคมชัดของ

ภาพขึ้นอยูกับจำนวนของพิกเซล ยิ่งมีจำนวนพิกเซลมากความละเอียดของภาพยิ่งสูง วิธีการคำนวณ

จำนวนพิกเซลในภาพ คือ  

จำนวนพิกเซลของภาพ = (ความกวาง x ความละเอียด) x (ความสูง x ความละเอียด) 

เชน มภีาพขนาดกวาง 6 น้ิวและสูง 4 น้ิว มีความละเอียดที่ 72 =pixels/inch มีจุดสีทั้งหมด

เทากับ (6 x 72) x (4 x 72) = 432 x 288 หรือ 124,416 pixels (ดวงพร เกี๋ยงคำ, 2553:117) 

ภาพท่ี 3-1 ลักษณะพิกเซลของภาพ 
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2) ประเภทของภาพในงานคอมพิวเตอรกราฟก  

โดยปกติคอมพิวเตอรมีการประมวลผลภาพอยู 2 รูปแบบ คือ ภาพแบบ Bitmap 

หรือ Raster  และภาพแบบ Vector  

ภาพแบบ Bitmap หรือเรียกอีกแบบวา Raster เปนภาพที่เกิดจากการเรียงตัวกัน

ของพิกเซลจนกลายเปนภาพ แตภาพมีจำนวนพิกเซลตายตัวตามการสรางภาพที่มีความ

ละเอียดแตกตางกัน ดังน้ันเมื่อมีการขยายภาพ ความละเอียดของภาพลดลง ทำใหสามารถ

มองเห็นพิกเซลเรียงตัวอยางชัดเจน ภาพ Bitmap มีขอดีคือ เหมาะสำหรับภาพที่มีการแสดง

เฉดสีและสีสันจำนวนมาก ไลคาน้ำหนักสีไดเปนธรรมชาติ สรางสี ระบายสี หรือกำหนดสี

อยางละเอียดสวยงามไดงาย ดังนั้น ภาพแบบ Bitmap จึงเหมาะกับงานดานภาพถายและ

งานระบายสี ไฟลของรูปภาพประเภทนี้คือ ภาพที่มีนามสกุลเปน .BMP, .PCX, .TIF, .GIF, 

.JPG, .MSP, .PCD, .PCT เปนตน (พงษศักด์ิ ไชยทิพย, 2549:102) และโปรแกรมที่ใชจัดการ

ภาพประเภทน้ีคือ โปรแกรม Paintbrush, Photoshop, PhotoScape, Lightroom เปนตน 

(6 x 72=432 pixels) 

6 น้ิว 

4 น้ิว 
(4 x 72=288 pixels) 

ภาพท่ี 3-2 ตัวอยางภาพถายขนาด 4x6 น้ิว ความละเอียด 72 pixels/inch มีจำนวน 

              พิกเซลทั้งหมด 124,416 pixels 
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ภาพแบบ Vector คือ ภาพที่สรางขึ้นดวยการนำจุดและเสนมาสรางเปนรูปราง 

รูปทรงจนกลายเปนภาพโดยใชหลักการ Vector ทางคณิตศาสตร สามารถลากเสนไปในแนว

ตาง ๆ ไดไมมีที ่สิ้นสุด ขอดีของภาพ Vector คือ สามารถขยายไปไดไมจำกัด โดยที่ไมลด

คุณภาพ เหมาะกับงานการตูนหรืองานกราฟกที่ตองการความคมชัดสูง เชน งานปายโฆษณา

หรือโปสเตอรที่มีขนาดใหญ แตขอเสียคือจะทำใหไฟลมีขนาดใหญตามไปดวย ภาพ Vector 

สามารถเปลี่ยนเปนภาพ Bitmap ได โดยที่ความละเอียดของภาพทีแ่ปลงออกมาจะขึ้นอยูกับ

การกำหนดคาความละเอียดและรูปแบบของไฟล  แตเมื่อเปลี่ยนเปนภาพ Bitmap แลว จะ

ไมสามารถแกไขหรือจัดการภาพโดยไมสูญเสียความละเอียดไดเหมือนเดิม โปรแกรมที่ใช

จ ั ดการภาพประ เภทน ี ้ ค ื อ  โปรแกรม  Illustrator, CorelDraw, AutoCAD เป  นต น             

สวนนามสกุลของไฟลประเภทน้ี คือ .ESP, .AI, .CDR, .DEW, .CGM เปนตน  

โดยทั่วไปภาพที่มีความละเอียดสูงหรือคุณภาพดี ควรจะมีคาความละเอียด 300 ppi 

ขึ้นไป คา ppi ยิ่งสูง ภาพก็จะมีความละเอียดคมชัดมากยิ่งขึ้น และเพื่อใหไดผลงานที่มีภาพ

ความคมชัด ไมแตกเบลอ นักออกแบบจะตองรูจักกำหนดคาความละเอียดของภาพให

เหมาะสมกับรูปแบบของงาน ดังน้ี 

คาความละเอียด 72 ppi สำหรับงานแสดงผลบนจอคอมพิวเตอร เชน งานออกแบบ

เว็บไซต แบนเนอรตาง ๆ เปนตน  

   คาความละเอียด 150 ppi สำหรับหรับภาพที่พิมพผานปรินเตอร  

 คาความละเอียด 300 ppi สำหรับงานสิ่งพิมพ เชน โปสเตอร ปกหนังสือ แผนพับ 

เปนตน   

ภาพท่ี 3-3 การขยายภาพแบบ Bitmap จนเห็นพิกเซลเรียงตัวกันเปนตาราง 
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หากนำภาพมาใชผิดประเภท เชน นำภาพแบนเนอรจากเว็บไซตที ่มีความละเอียด 

72 ppi มาใชพิมพในแผนพับที่จะตองใชภาพที่มีความละเอียดอยางต่ำคือ 300 ppi จะทำให

ภาพในแผนพับที่พิมพออกมาน้ันไมคมชัดหรือที่เรียกกันวา ภาพแตกน่ันเอง 

 

 

 

 

 

ภาพท่ี 3-4 เปรียบเทียบความละเอียดของภาพระหวาง 72 ppi (ซาย) และ 300 ppi (ขวา) 

 

3.3.3    รูปแบบของไฟลกราฟกแบบตาง ๆ 

BMP (Bitmap) เปนไฟลมาตรฐานของวินโดว ประกอบไปดวยจุดเล็ก ๆ เรียงกันจนเปนภาพ

ตามความละเอียดของภาพ ภาพที่มีความละเอียดสูงจะมีขนาดใหญใชงานไมสะดวก ภาพที่มีความ

ละเอียดนอย เมื่อขยายใหใหญความละเอียดของภาพจะลดลง เหมาะสำหรับงานภาพเหมือนจริง  

JPEG (Joint Photographic Experts Group) เปนไฟลที่สรางขึ้นมาเพื่อบีบอัดขอมูลภาพ 

แสดงผลได 16 ลานสี เหมาะกับงานภาพถาย ภาพสแกนและเว็บไซต สามารถต้ังคาการบีบอัดได แต

จะสูญเสียรายละเอียดในการแสดงผลทุกคร้ังที่มีบีบอัดไฟลภาพ  

GIF (Graphic Interchange File) เปนไฟลที่มีการบีบอัดขอมูลสูง ทำใหภาพมีขนาดเล็ก 

แสดงสีไดเพียง 256 สี เหมาะกับงานที่มีจำนวนสีไมเยอะและไมมีการไลคาน้ำหนักสีมาก สามารถทำ

เปนไฟลแอนิเมชันได นิยมนำมาใชงานในระบบอินเทอรเน็ตเน่ืองจากสามารถดาวโหลดไดรวดเร็ว   

PNG (Portable Network Graphics) เปนไฟลภาพที่รวมคุณสมบัติที่ดีของไฟล JPEG และ 

GIF เขาไวดวยกัน มีการบีบอัดไฟลใหมีขนาดเล็กและดีกวาไฟล GIF ทำใหไดไฟลที ่มีขนาดเล็กแต

สูญเสียรายละเอียดในการแสดงผลนอยและยังสามารถเลือกเซฟไฟลการแสดงผลของสีระหวาง 256 

สี และ 16 ลานสี แตไมสามารถทำไฟลแอนิเมชันได  

TIFF (Tagged Image File Format) เปนไฟลที่ไมมีการบีบอัดขอมูล แสดงผลของสีไดทุก 

ระดับตั้งแตสีขาวดำไปจนถึงภาพสีความละเอียดสูง หากมีการแกไขภาพจากโปรแกรมตาง ๆ  ไฟล 
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TIFF ยังสามารถเก็บเลเยอรไวได สงผลใหมีขนาดไฟลคอนขางใหญ นิยมใชกันในงานกราฟก สื่อ 

สิ่งพิมพ 

RAW file เปนไฟลรูปภาพที่เกิดจากการบันทึกของกลองถายรูป DSLR เซ็นเซอรของกลอง

เห็นภาพอยางไรก็สงขอมูลมาเปนไฟล RAW อยางน้ัน เปนไฟลที่ยังไมผานการปรับแตง ไมถูกบีบอัด 

เพิ่มความคมชัด หรือเรงสี มีประสิทธิภาพสูงในการนำมาตกแตงแกไขภาพในภายหลัง ขอเสียของไฟล 

RAW คือ มีขนาดใหญมากทำใหกินพื้นที่ในการจัดเก็บและตองใชโปรแกรมเฉพาะในการเปดไฟลภาพ

ไมวาจะเปนการเปดดูหรือเปดเพื่อแกไขภาพ เชน เชน โปรแกรม Photoshop, Lightroom, Camera 

Raw เปนตน  

PSD (Photoshop Document) เปนไฟลที่ใชสำหรับโปรแกรม Photoshop โดยเฉพาะ 

สามารถบันทึกแบบแยกเลเยอรและประวัติการทำงานตาง ๆ ทำใหไฟลมีขนาดคอนขางใหญ นอกจาก

การเปดดวยโปรแกรม Adobe Photoshop แลว ยังสามารถใชโปรแกรมอื่นเปดดูไฟลภาพหรือทำ

การแกไขไดดวย เชน โปรแกรม ACDsee, Adobe ImageReady, Adobe Illustrator เปนตน  

 3.3.4    สีในงานคอมพิวเตอรกราฟก 

1)   ความเขมของสี โดยสวนใหญสายตาของมนุษยสามารถแยกสีออกไดเปน 3 ลักษณะ คือ 

Hue Saturation และ Brightness 

Hue คือ สีตาง ๆ ของวัตถุ โดยแตละสีจะแตกตางกันตามความยาวของคลื่นแสงที่

กระทบวัตถุแลวสะทอนกลับมายังสายตาของเรา Hue จะแทนคาสีดวยองศา จาก 0 ถึง 360 

องศา  

 

 

 

 

Saturation คือ ความสดของสี วัดเปนเปอรเซ็นตจากปริมาณสีเทาที่มีอยูในสีน้ัน 

0% แสดงวามีสีเทามากที่สุด ความสดของสีเปน 0 100% แสดงวามีสีเทามากที่สุด มีความ

สดของสีสูงที่สุด  

 

 

ภาพท่ี 3-5 Hue ที่แทนคาสีดวยองศา  

0 O 180 O 360 O 



30 
 

 

 

 

 

Brightness คือ ความสวางและความมืดของสี มีความสัมพันธกับแสงและเงา การ

วัดคาความสวางจะคำนวณจากปริมาณสีดำที่ผสมอยู โดยมีการกำหนดคาเปนเปอรเซ็นต 

จาก 0% คือ สีดำ มืดที่สุด จนถึง 100% คือ สีขาว สวางมากที่สุด 

 

 

 

 

2)   การผสมสี (Color Mixing) คือการนำแมสี 3 สีมาผสมเขาดวยกัน แบงไดเปน 2 รูปแบบ 

คือ  

การผสมสีแบบบวก (additive color mixing) เปนการผสมกันของสีของแสง มีแมสี

หลักอยู 3 สี คือ สีแดง (Red) สีเขียว (Green) และสีน้ำเงิน (Blue) เรียกวาระบบสี RGB เมื่อ

ฉายแมสีแสงสามสีนี ้ลงบนฉากสีขาว คลื่นแสงเกิดการซอนทับกันทำใหเกิดการบวกและ

รวมตัวกันของความยาวคลื่นแสง จะทำใหเกิดสีตาง ๆ ขึ้น แมสีหลักทั้ง 3 สีน้ี เรียกวาสีขั้นที่ 

1 เมื่อนำแมสีสองสีมาผสมในอัตราสวนที่เทากันก็จะไดสีขั้นที่ 2 ดังน้ี  

    สีน้ำเงิน +   สีเขียว     = สีน้ำเงินแกมเขียว (cyan) 

       สีแดง +   สีน้ำเงิน     =       สีแดงแกมมวง (magenta) 

    สีแดง +   สีเขียว    = สีเหลือง (Yellow) 

เมื่อนำแมสีทั้ง 3 สีมาผสมเขาดวยกันจะไดเปนแสงสีขาว แตถาไมมีสีใด ๆ เลย จะไดเปนสีดำ 

 

 

 

ภาพท่ี 3-6 แสดงความสดของสี 

0% 100% 

0% 100% 

ภาพท่ี 3-7 แสดงความสวางและความมืดของสี 
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การผสมสีแบบลบ (Subtractive Color Mixing) คือ การที่แสงสีขาวสองมากระทบ

โดนวัตถุ วัตถุน้ันจะดูดกลืนความยาวคลื่นแสงบางระดับไว ทำใหปริมาณแสงสะทอนออกมา

ลดลง จึงเปนที่มาของการผสมสีแบบลบ ดังน้ันแมสีหลักทั้ง 3 สี ประกอบไปดวยสีชมพูมวง 

(magenta) สีฟา (cyan) และสีเหลือง (Yellow) เปนสีขั้นที่ 1 และเมื่อนำแมสีสองสีมาผสม

ในอัตราสวนที่เทากันก็จะไดสีขั้นที่ 2 ดังน้ี 

สีฟา   +   สีเหลือง = สีเขียว  

สีชมพูมวง +   สีฟา  =       สีมวง 

สีชมพูมวง +   สีเหลือง = สีสม  

และเมื่อนำแมสีทั้ง 3 สีมาผสมเขาดวยกัน จะไดเปน แสงสีดำ แตถาไมมีสีใด ๆ เลย 

จะไดเปนสีขาว 

 

 

 

 

 

 

 

ภาพท่ี 3-8 การผสมสีแบบบวก (additive color mixing) 

ภาพท่ี 3-9 การผสมสีแบบลบ (Subtractive Color Mixing) 
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3)   โหมดสี (Color Mode) ระบบสีของไฟลภาพ ซึ่งแตละโหมดสีจะแตกตางกันออกไปตาม

การใชงาน สำหรับ Photoshop มีโหมดสีดวยกันทั้งหมด 8 โหมด คือ 

Bitmap เปนโหมดภาพขาว-ดำที่แสดงสีไดเพียง 2 สี คือสีขาวและสีดำเทาน้ัน ไมมี

การไลน้ำหนักออนแก ทำใหภาพที่ไดมีความละเอียดนอยที่สุด เหมาะสำหรับภาพลายเสน 

Grayscale เปนโหมดภาพขาว-ดำ ที่มีการแสดงสี 3 สีคือ ขาว ดำ เทา สามารถไล

น้ำหนักไดถึง 256 ระดับ  

Duotone เปนภาพแบบ 2 โทนสีที่พัฒนามาจากภาพ Grayscale สามารถกำหนดสี

ใหเขามาไลน้ำหนักไดแทนสีขาวและสีดำ สรางไดทั ้งภาพสีเดียว (Monotone) ภาพ 2 สี 

(duotone) ภาพ 3 สี (Tritone) และภาพ 4 สี (Quadtone)  

Indexed Color เปนภาพที่จำกัดจำนวนสีที่แสดงใหสูงสุดเพียงแค 256 สี เทาน้ัน 

ทำใหขนาดของภาพไมใหญมากนักและมีคุณภาพต่ำ  

RGB Color เปนโหมดที่ใช channels แสดงสีจำนวน 3 สี ตามแมสีของแสง คือ สี

แดง สีเขียวและสีน้ำเงิน ในแตละสีจะแสดงคาสีได 256 สี เมื่อรวมกันทั้ง 3 สีจะแสดงคาสีได

สูงสุดถึง 16.7 ลานสี เหมาะสำหรับใชตกแตงเพราะสามารถแสดงคาสีไดมาก 

CMYK เปนโหมดที่ใช channels ในการแสดงสีจำนวน 4 สี คือ สีฟา (Cyan) สีชมพู

มวง (Magenta) สีเหลือง (Yellow) และสีดำ (Black) เปนโหมดสำหรับการพิมพเพื่อใหได

ภาพที่ใกลเคียงกับภาพถายมากที่สุด 

Lab Color เปนโหมดสีที่แยก channels แมสีและคาแสงออกจากกัน โดยใชคา 

Lightness แทนความสวาง คา a แทนสีเขียวถึงแดง คา b แทนสีน้ำเงินถึงเหลือง เปนโหมด

ที่ใหสีไดเหมือนจริงที่สุด เหมาะกับงานแตงภาพถาย 

Multichannel เปนโหมดสีที่มีระบบแบบ CMYK แตไมมี channels สีดำ (K-Black) 

มีสีไดสูงสุดเพียง 256 สี เหมาะกับการพิมพที่ตองการผลลัพธพิเศษในการพิมพ 
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3.3 สวนประกอบในหนาตางของโปรแกรม Adobe photoshop cc 

 

 

 

     

 

 

 

 

1. Menu Bar เปนแถบรวบรวมชุดคำสั่งทั้งหมดของโปรแกรม แยกเปนหมวดหมูตามรูปแบบการใช

งานดังตารางตอไปน้ี  

ตารางท่ี 3-1 ตารางรูปแบบการทำงานชุดคำสั่งของโปรแกรม Adobe Photoshop cc 

เมนู รูปแบบการทำงาน  

File จัดการกับไฟลภาพในการสรางไฟลใหม เปด ปดไฟลในรูปแบบตาง ๆ บันทึก Import  

Export และอ่ืน ๆ ที่เกี่ยวกับไฟลภาพไฟล  

Edit ใชสำหรับการแกไข ปรับแตงภาพ เชน ตัด คัดลอก วาง เติมสี รวมถึงปรับแตงคา 

เบื้องตนของโปรแกรม เชน คาสี คำสั่งลัดของโปรแกรม ปรับแตง Toolbar เปนตน  

Image สำหรับการปรับแตงภาพที่แสดงผลทั้งภาพ เชน แกไขความสวาง ปรับโหมดสี ปรับ

ขนาดของภาพ เปนตน  

Layer จัดการเลเยอรของไฟลภาพ เชน สรางเลเยอรใหม รวมเลเยอร แปลงเลเยอร การ 

จัดการเลเยอร เปนตน 

Type จัดการขอความตาง ๆ เชน แกไขขอความ แกไขรูปแบบของตัวอักษร ปรับแตงสี 

ตัวอักษร เปนตน 

Select จัดการ Selection  โดยสามารถปรับแตง บันทึกและเรียก Selection มาใชงานได  

เปนตน 

ภาพท่ี 3-10 สวนประกอบของโปรแกรม Adobe photoshop cc 

Option bar 2 

Toolbox 

3 4 
Panel 

Menu 
Workspace 

5 

Artboard 

6 

Menu Bar 1 
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เมนู รูปแบบการทำงาน  

Filter ปรับแตงภาพโดยอัตโนมัติ เชน ทำภาพเบลอ ทำภาพใหเกิด Noise หรือทำภาพลาย

น้ำ เปนตน   

3D จัดการไฟลสามมิติ เชน สรางภาพสามมิติ สรางรูปทรงสามมิติ จัดการไฟลสามมิติ  

เปนตน  

 View กำหนดมุมมองของภาพในรูปแบบตาง ๆ เชน การยอขยาย การแสดง Grid Guide ไม 

บรรทัด  

 Window ใชสำหรับการกำหนดรูปแบบพื้นที่การทำงานและใชสำหรับเปด-ปดพาเนลตาง ๆ 

 Help รวบรวมวิธีการและคำแนะนำในการใชงาน Adobe Photoshop 
 

 

 

 

 

 การเรียกใช Menu Bar สามารถใชเมาสคลิกเรียกใชคำสั่งในแถบ Menu Bar ได หากคำสั่งไหนมีรูป

ลูกศร    แสดงวามีคำสั่งยอยอยูในคำสั่งหลักอีกที เลือกคำสั่งยอยโดยการเลื่อนเมาสไปตรงคำสั่งหลัก จะมี

หนาตางของคำสั่งยอยปรากฏขึ้นมา แลวเลื่อนเมาสไปเลือกคำสั่งยอยที่ตองการได 

 

 

 

 

 

 

 

 

ภาพท่ี 3-11 แถบคำสั่ง Menu Bar 

 

ภาพท่ี 3-12 การเลือกใชคำสั่งยอยใน Menu Bar 
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 การเรียกใช Menu Bar สามารถทำไดอีกวิธีหน่ึงนอกเหนือจากการใชเมาสคลิกเลือกคำสั่ง คือการใช 

คียลัดเรียกคำสั่ง 

 

 

 

 

 

 

 

2. Option bar เปนแถบที่ใชปรับแตงคาตาง ๆ ของเคร่ืองมือ เชน เมื่อเลือกเคร่ืองมือพูกัน Option 

bar จะแสดงขนาดหัวพูกัน ความคมชัดในการใชพูกัน หรือเมื่อเลือก Type Tool  Option bar 

จะแสดงชื่อฟอนท ขนาดของฟอนท ความหนาบางของฟอนท เปนตน 

 

 

 

 

หากมีการเรียกใชเคร่ืองมือบอย ๆ สามารถบันทึกคาการทำงานของเคร่ืองมือได ดังน้ี 

1. เลือกเคร่ืองมือที่ตองการบันทึก 

2. กำหนดคาเคร่ืองมือตามที่ตองการ 

3. คลิกปุมสามเหลี่ยม 

4. คลิกปุมสี่เหลี่ยมพับมุม  

5. ต้ังชื่อ 

6. คลิก Ok  

ภาพท่ี 3-14 Option Bar ของ Type Tool 

ภาพท่ี 3-13 คียลัดที่ใชเรียกคำสั่งของ Menu Bar 
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3. Toolbox เปนกลองที่รวบรวมเคร่ืองมือที่ใชในการตกแตง แกไข สรางสรรคภาพและงานกราฟก 

การแสดงผลของ Toolbox จะแตกตางกันออกไปตาม Workspace ที่เลือกใช แบงเปน 8 กลุม 

ตามลักษณะการใชงาน ดังน้ี  

ตารางท่ี 3-2 กลุมเคร่ืองมือสำหรับเคลื่อนยายวัตถุและสราง Selection 

เคร่ืองมือ รูปแบบการทำงาน 

Move Tool ใชเคลื่อนยายวัตถุหรือรูปภาพไปยังตำแหนงที่ตองการ 

Artboard Tool  ใชสราง Artboard ในเพิ่มหรือลดพื้นที่การทำงาน  

Rectangular Marquee Tool   ใชสราง Selection รูปทรงสี่เหลี่ยม  

Elliptical Marquee Too   ใชสราง Selection รูปทรงกลมหรือทรงรี 

Single Row Marquee Tool ใชสราง Selection รูปทรงเสนตรงแนวนอน ความสูง 1 พิกเซล 

Single Column Marquee Tool ใชสราง Selection รูปทรงเสนตรงแนวต้ัง ความกวาง 1 พิกเซล 

Lasso Tool ใชสราง Selection แบบรูปทรงอิสระ  

Polygonal Lasso Tool  ใชสราง Selection แบบเหลี่ยมมุม 

ภาพท่ี 3-15 วิธีบันทึกคาเคร่ืองมือที่ตองใชเปนประจำ 

 

1 

เลือกเครื่องมือ 

ที่ตองการบันทึก 

2 กำหนดคาเครื่องมือ

ตามที่ตองการ 
3 คลิกปุมสามเหลี่ยม 

4 
คลิกปุม 

สี่เหลี่ยมพับมมุ 

5 

ต้ังชื่อ 

6 

คลิก Ok 
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เคร่ืองมือ รูปแบบการทำงาน 

Magnetic Lasso Tool  ใชสราง Selection ในพื้นที่ที่มีขอบของวัตถุชัดเจน โดยการคลิก

แลวลากเมาสไปตามขอบวัตถุ 

Quick Selection Tool  ใชสราง Selection ในพื้นที่ที่มีขอบของวัตถุชัดเจน โดยการคลิก

เมาสคางไวแลวลากเมาสผานวัตถุ 

Magic Wand Tool  ใชสราง Selection ในพื้นที่ที่มีสีใกลเคียงกัน  

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-3 กลุมเคร่ืองมือสำหรับการตัดภาพหรือวัตถุ 

เคร่ืองมือ รูปแบบการทำงาน 

Crop Tool ใชตัดภาพใหเล็กลงเหลือเฉพาะสวนที่ตองการ 

Perspective Crop Tool ใชตัดภาพที่มีปญหาทางดานมุมมองใหกลายเปนมุมแบบปกติ 

Slice Tool ใชตัดภาพออกเปนชิ้นเล็ก ๆ 

Slice Select Tool ใชปรับแตงภาพที่ตัดดวยเคร่ืองมือ Slice Tool 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-4 กลุมเคร่ืองมือสำหรับวัดคาตาง ๆ 

เคร่ืองมือ รูปแบบการทำงาน 

Eyedropper Tool ใชเลือกสีที่ตองการไปใชงาน 

3D Material Eyedropper Tool ใชเลือกสีหรือพื้นผิวที่ตองการไปใชในงาน 3D 

Color Sampler Tool ใชแสดงตัวอยางของสี โดยแสดงไดสูงสุด 4 สีตอคร้ัง 

Ruler Tool ใชวัดระยะตามตำแหนงที่ตองการ 

Note Tool ใชแทรกขอความในโปรเจค สำหรับการทำงานรวมกับผูอ่ืน 

Count Tool ใชนับจำนวนวัตถุในภาพหรือให Photoshop นับจำนวน

พื้นที่ในภาพใหโดยอัตโนมัติ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 
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ตารางท่ี 3-5 กลุมเคร่ืองมือสำหรับการรีทัชภาพ 

เคร่ืองมือ รูปแบบการทำงาน 

Spot Healing Brush Tool ใชลบสิวและแกไขจุดบกพรองเล็ก ๆ  

Healing Brush Tool ใชซอมแซมจุดบกพรองขนาดใหญ  โดยการกดปุม Alt (Win) / 

Option (Mac) คางไวแลวคลิกสุมตัวอยางจากพื้นผิวที่ดี แลว

คลิกทับบริเวณที่มีปญหาเพื่อซอมแซม 

Patch Tool ใชซอมแซมพื้นผิวขนาดใหญ โดยการวาดโครงรางอิสระรอบ ๆ

บริเวณที่มีปญหา 

Content-Aware Move Tool ใชสำหรับยายสวนของรูปภาพไปยังพื้นที่อ่ืน โดยโปรแกรมจะทำ

การเติมพื้นหลังใหดวย 

Red Eye Tool ใชแกไขตาสีแดงที่สะทอนแสงแฟลชจากกลอง 

Clone Stamp Tool ใชแกไขพื้นผิวที่มีปญหาโดยการก็อปปพื้นผิวมาแลวแปะทับ 

Pattern Stamp Tool ใชเพื่อแตม Pattern ลงบนรูปภาพ โดยสามารถเลือก Pattern 

ไดที่ Option bar 

Eraser Tool ใชลบพื้นที่ที่ไมตองการออก  

Background Eraser Tool ใชลบพื้นหลังที่มีสีใกลเคียงกันออกจากภาพ 

Magic Eraser Tool ใชลบพื้นที่ที่มีสีใกลเคียงกันออกจากภาพ โดยการคลิกแคคร้ัง

เดียว 

Blur Tool  ทำใหภาพเบลอขึ้นดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Sharpen Tool  ทำใหภาพชัดขึ้นดวยการคลิกหรือลากเมาสในบริเวณที่ตองการ 

Smudge Tool  ใชเกลี่ยสีดวยการคลิกหรือลากเมาสในบริเวณที่ตองการ 

Dodge Tool ปรับใหภาพสวางขึ้น ดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Burn Tool  ปรับใหภาพมืดขึ้น ดวยการคลิกหรือลากเมาสในบริเวณที่

ตองการ 

Sponge Tool  เพิ่มหรือลดความอ่ิมตัวของสี ดวยการคลิกหรือลากเมาสใน

บริเวณที่ตองการ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 
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ตารางท่ี 3-6 กลุมเคร่ืองมือสำหรับการระบายสีและการลงสี 

เคร่ืองมือ รูปแบบการทำงาน 

Brush Tool ใชระบายสี ทั้งแบบสีพื้นและแบบลวดลาย 

Pencil Tool ใชระบายสีแบบเดียวกับ Brush Tool แตขอบที่ไดจะมีความ

หยาบกวา Brush Tool 

Color Replacement Tool  ใชเปลี่ยนสีของภาพโดยการระบายทับลงไป 

Mixer Brush Tool  เปนแปรงแบบผสม ใชแปลงภาพถายใหเปนภาพวาด 

History Brush Tool ใชยอนกลับการทำงานของแปรง โดยการลากเมาสไปบนภาพ 

Art History Brush Tool  ใชแปลงภาพถายใหกลายเปนภาพวาด 

Gradient Tool ใชไลระดับสี 

Paint Bucket Tool ใชเทสีหรือลวดลาย  

Foreground-Background ใชกำหนดสีพื้นหนาและพื้นหลัง 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-7 กลุมเคร่ืองมือสำหรับการสรางเวคเตอรและตัวอักษร 

เคร่ืองมือ รูปแบบการทำงาน 

Pen Tool ใชวาดเสนพาธที่เปนเสนตรงและเสนโคง  

Freeform Pen Tool ใชวาดเสนพาธแบบอิสระ สามารถปรับแตงไดในภายหลัง 

Curvature Pen Tool  ใชวาดเสนพาธที่เปนเสนโคง 

Add Anchor Point Tool  ใชเพิ่มจุดยึดในเสนพาธ เพื่อใหปรับแตงเสนพาธไดละเอียด

ขึ้น 

Delete Anchor Point Tool  ใชลบจุดยึดออกจากเสนพาธ 

Convert Point Tool  ใชปรับเสนพาธและจุดยึดใหเปนเสนโคงหรือเปนมุม 

Path Selection Tool ใชยายตำแหนงของเสนพาธ 

Direct Selection Tool ใชปรับแตงเสนพาธและจุดยึด 

Horizontal Type Tool ใชสรางขอความแนวนอน 

Vertical Type Tool ใชสรางขอความแนวต้ัง 

Horizontal Type Mask Tool ใชสรางขอความแนวนอนแบบ Selection 

Vertical Type Mask Tool  ใชสรางขอความแนวต้ังแบบ Selection 
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เคร่ืองมือ รูปแบบการทำงาน 

Rectangle Tool  ใชสรางรูปทรงสี่เหลี่ยม 

Rounded Rectangle Tool  ใชสรางรูปทรงสี่เหลี่ยมของมน 

Ellipse Tool ใชสรางรูปทรงกลมและทรงรี 

Polygon Tool ใชสรางรูปทรงหลายเหลี่ยม 

Line Tool ใชสรางเสนตรง 

Custom Shape Tool ใชสรางรูปทรงอิสระที่โปรแกรมจัดเตรียมให 

หมายเหตุ. (เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-8 กลุมเคร่ืองมือสำหรับสำหรับการจัดการมุมมองของภาพ 

เคร่ืองมือ รูปแบบการทำงาน 

Hand Tool ใชเลื่อนดูสวนตาง ๆ ของภาพเมื่อมีการขยายภาพ 

Rotate View Tool ใชเอียงภาพในมุมตาง ๆ  

Zoom Tool ใชยอ-ขยายมุมมองภาพ 

หมายเหตุ. (Patterson, 2020; เกียรติพงศ บุญจิตร, 2560) 

ตารางท่ี 3-9 กลุมเคร่ืองมือสำหรับการจัดการโหมดของหนาจอ 

เคร่ืองมือ รูปแบบการทำงาน 

Edit in Standard Mode - Edit in       

Quick Mask Mode 

ใชแสดงและแกไขภาพในโหมดปกติและในโหมด 

Quick Mask 

Standard Screen Mode  แสดงหนาจอในแบบโหมดปกติ 

Full Screen Mode with Menu Bar  แสดงแบบเต็มหนาจอโดยไมมีไตเต้ิลบาร 

Full Screen Mode  แสดงแบบเต็มหนาจอโดยมีพื้นหลังสีดำ 

หมายเหตุ. (เกียรติพงศ บุญจิตร, 2560) 

 

 Toolbox จะมีการรวมเครื่องมือที่ใชงานเหมือนกันแตคนละรูปแบบใหอยูในปุมเดียวกัน โดยจะมี

สามเหลี่ยมเล็กอยูดานลางขวาของปุม หากตองการใชเคร่ืองมือใหคลิกคางไว หนาตางที่แสดงเคร่ืองมือยอยจะ

ปรากฎขึ้น 
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4. Panel เปนหนาตางที่ใชทำงานกับรูปภาพในแบบตาง ๆ เชน Color Panel ใชสำหรับเลือกสี 

Layers Panel ใชสำหรับจัดการกับเลเยอร History Panel ใชสำหรับยอนการทำงานหลาย ๆ 

ขั้นตอน เปนตน  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-17 ตัวอยาง Character Panel และ Swatches Panel 

  

ภาพท่ี 3-16 เคร่ืองมือยอยของ Selection  
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การยอ-ขยาย Panel สามารถทำไดโดยการคลิกปุม         หรือ         ดานมุมบนขวาของ

หนาตาง 

 

 

 

 

 

 

 

 

 

 

การปด Panel ใหคลิกขวาที่ Panel แลวเลือก Close เพื่อปด Panel เดียว หรือ Close 

Tab Group เพื่อปด Panel ทั้งกลุม 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-19 การปด Panel 

ภาพท่ี 3-18 การยอ-ขยายของ Panel 
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การซอน-แสดง Panel ใชสำหรับซอน Panel ที่ยังไมตองการใชงานและใหแสดง Panel ที่

ตองการใชงาน เพื่อเปนการประหยัดพื้นที่ในการทำงาน โดยการดับเบิลคลิกที่ Panel 

 

 

 

 

 

 

 

 

 

 

 

หากตองการใชงาน Panel อ่ืน  ๆ นอกเหนือจากที่โปรแกรมมีให สามารถเลือกใชงานไดจาก

แถบ Menu Bar -> Window 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-21 การเรียกใชงาน Panel 

ภาพท่ี 3-20 การซ่อน-แสดง Panel 
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5. Workspace Menu คือการกำหนดรูปแบบของการแสดงเครื่องมือ พาเนลตาง ๆ  ใหเหมาะสม

กับรูปแบบของงาน โดยโปรแกรมจะเลือกเครื่องมือที่เราจำเปนจะตองใชกับงานมาให โดย 

Adobe Photoshop CC มีใหเลือกอยู 6 รูปแบบ คือ  

1) Essentials [Default] เปน Workspace พื้นฐานที่โปรแกรมกำหนดใหเมื่อเปด

ใชงานคร้ังแรก เหมาะกับการใชงานทั่วไป  

 

 

 

 

 

 

 

2) 3D เหมาะกับการสรางงานในรูปแบบสามมิติ 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-22 การทำงานใน Workspace Essentials [Default] 

ภาพท่ี 3-23 การทำงานใน Workspace 3D 



45 
 

3) Graphic and Web เหมาะกับงานดานกราฟกและเว็บไซตทั่วไป 

 

 

 

 

 

 

 

 

 

4) Motion เหมาะกับงานดานแอนิเมชัน ทำภาพใหเคลื่อนไหว 

 

 

 

 

 

 

 

 

 

ภาพท่ี 3-24 การทำงานใน Workspace Graphic and Web 

ภาพท่ี 3-25 การทำงานใน Workspace Motion 
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5) Painting เหมาะกับงานดานการวาดรูป ระบายสี 

 

 

 

 

 

 

 

 

6) Photography เหมาะกับงานดานภาพถาย ปรับความสวางรูป ปรับแสงเงาของ

ภาพ 

 

 

 

 

 

 

 

 

ภาพท่ี 3-26 การทำงานใน Workspace Painting 

ภาพท่ี 3-27 การทำงานใน Workspace Photography 
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 การเรียกใชงาน Workspace สามารถทำได 2 วิธี คือ 

1) คลิกเลือก Window ตรง Menu Bar เลื่อนเมาสไปที่คำวา Workspace แลวคลิกเลือก 

Workspace ตามตองการ 

 

 

 

 

 

 

 

 

 

2) คลิกปุม               มุมบนขวาของโปรแกรม แลวเลือก Workspace ตามตองการ 

 

 

 

 

 

 

 

 

    

ภาพท่ี 3-29 การเรียกใชงาน Workspace โดยการคลิกปุม              มุมบนขวาของโปรแกรม 

ภาพท่ี 3-28 การเรียกใชงาน Workspace โดยการคลิก Window ตรง Menu Bar  
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6. Artboard คือ พื้นที่สำหรับการทำงาน เปรียบเสมือนกระดาษหรือผืนผาใบ ในไฟลงาน 1 ไฟล

สามารถมี Artboard ไดมากกวา 1 ชิ้นงาน  

 

 

 

 

 

 

 

 

 

3.5    คียลัดในการใชงานของโปรแกรม Adobe Photoshop cc 

 คียลัด คือ การเรียกใชคำสั่งของโปรแกรม โดยการกดบนแปนพิมพ จะชวยใหทำงานไดอยางรวดเร็ว

ยิ่งขึ้น โดยแยกเปนหมวดหมูดังตารางดังตอไปน้ี 
 

ตารางท่ี 3-10 คียลัดคำสั่ง File 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

New Ctrl + N Command + N 

Open Ctrl + O Command + O 

Open as Alt + Shift + Ctrl + O Option + Shift + Command + O 

Close Ctrl + W Command + W 

Close All Alt + Ctrl + W Option + Command + W 

Close and Go to Bridge Shift-Ctrl-W Shift-Command-W 

Save Ctrl + S Command + S 

Save as Shift + Ctrl + S Shift + Command + S 

Export As  Alt + Shift + Ctrl + W Option + Shift + Command + W 

ภาพท่ี 3-30 พื้นที่การทำงานของ Artboard 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Save for Web Alt + Shift + Ctrl + S Option + Shift + Command + S 

Exit Ctr l+ Q Command + Q 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-11 คียลัดคำสั่ง Edit 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Undo Ctrl + Z Command + Z 

Redo Shift + Ctrl + Z Shift + Command + Z 

Cut Ctrl + X Command + X 

Copy Ctrl + C Command + C 

Paste Ctrl + V Command + V 

Paste in Place Shift + Ctrl + V Shift + Command + V 

Search Ctrl + F Command + F 

Free Transform Ctrl + T Command + T 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-12 คียลัดคำสั่ง Tool 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Move tool V V 

Rectangular Marquee tool         

Elliptical Marquee tool               
M M 

Lasso tool                            

Polygonal Lasso tool               

Magnetic Lasso tool 

L L 

Crop tool                                    

Slice tool                                    

Slice Select tool 

C C 

Eyedropper tool                            

Color Sampler tool                      
I I 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Ruler tool                                   

Note tool 

Spot Healing Brush tool                 

Healing Brush tool                      

Patch tool                                    

Red Eye tool 

J J 

Brush tool                                   

Pencil tool                                

Color Replacement tool                 

Mixer Brush tool 

B B 

Clone Stamp tool                     

Pattern Stamp tool 
S S 

History Brush tool                          

Art History Brush tool 
Y Y 

Eraser tool                         

Background Eraser tool               

Magic Eraser tool 

E E 

Gradient tool                             

Paint Bucket tool 
G G 

Dodge tool                                           

Burn tool                                      

Sponge tool 

O O 

Pen tool                                  

Freeform Pen tool 
P P 

Horizontal Type tool                           

Vertical Type tool                        

Horizontal Type mask tool                 

Vertical Type mask tool 

T T 

Path Selection tool                          

Direct Selection tool 
A A 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Rectangle tool                                    

Rounded Rectangle tool              

Ellipse tool                                     

Polygon tool                                    

Line tool                                      

Custom Shape tool 

U U 

Hand tool H H 

Rotate View tool R R 

Zoom tool Z Z 

Default Foreground/Background 

colors 

D D 

Switch Foreground/Background 

colors 

X X 

สลับ Standard และ Quick Mask 

modes 

Q Q 

Perspective Crop tool C C 

Artboard tool V V 

Rotate View tool R R 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-13 คียลัดคำสั่ง Image 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Adjustments  

       Levels 

       Curves 

       Hue/Saturation 

       Color Balance 

       Black & White 

       Invert 

 

Ctrl + L 

Ctrl + M 

Ctrl + U 

Ctrl + B 

Alt + Shift + Ctrl + B 

Ctrl + I 

 

Command + L 

Command + M 

Command + U 

Command + B 

Shift + Command + Option + B 

Command + I 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

       Desaturate Shift + Ctrl + U Shift + Command + Option + U 

Auto Tone Shift + Ctrl + L Shift + Command + L 

Auto Contrast Alt + Shift + Ctrl + L Option + Shift + Command + L 

Auto Color Shift + Ctrl + B Shift + Command + B 

Image Size Alt + Ctrl + I Option + Command + I 

Canvas Size Alt + Ctrl + C Option + Command + C 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-14 คียลัดคำสั่ง Layer  

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

New Layer Shift + Ctrl + N Shift + Command + N 

New Layer Via Copy Ctrl + J Command + J 

New Layer Via Cut Shift + Ctrl + J Shift + Command + J 

Group Layers Ctrl + G Command + G 

Ungroup Layers  Shift + Ctrl + G Shift + Command + G 

Hide Layers Ctrl + , Command + , 

Arrange                                  

 Bring to Front 

 Bring Forward 

 Send Backward 

 Send to Back 

 

Shift + Ctrl + ] 

Ctrl + ] 

Ctrl + [ 

Shift + Ctrl + [ 

 

Shift + Command + ] 

Command + ] 

Command + [ 

Shift + Command + [ 

Lock Layers Ctrl + / Command + / 

Select all layers Ctrl + Alt + A Command + Option + A 

Merge visible layers Ctrl + Shift + E Command + Shift + E 

Merge layers เลือกเลเยอรที่ตองการ + Ctrl + 

E 

เลือกเลเยอรที่ตองการ + 

Command + E 

หมายเหตุ. (Default keyboard shortcuts, 2021) 
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ตารางท่ี 3-15 คียลัดคำสั่ง Type 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

สราง Text layer ใหม Shift-click Shift-click 

จัดขอความใหชิดซาย ตรงกลาง 

ขวา 

Horizontal Type tool + Ctrl 

+ Shift + L, C, R 

Horizontal Type tool + 

Command + Shift + L, C, R 

จัดขอความใหชิดดานบน ตรง

กลาง ดานลาง 

Vertical Type tool + Ctrl + 

Shift + L, C, R 

Vertical Type tool + 

Command + Shift + L, C, R 

horizontal scale 100% Ctrl + Shift + X Command + Shift + X 

vertical scale 100% Ctrl + Shift + Alt + X Command + Shift + Option 

+ X 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-16 คียลัดคำสั่ง Select 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Select All Ctrl + A Command + A 

Deselect Ctrl + D Command + D 

Reselect Shift + Ctrl + D Shift + Command + D 

Inverse Shift + Ctrl + I Shift + Command + I 

All Layers Alt + Ctrl + A Option + Command + A 

Find Layers Alt + Shift + Ctrl + F Option + Shift + Command + F 

Select and Mask  Alt + Ctrl + R Option + Command + R 

Add Selection Selection Tool + Shift +ลาก

เมาส 

Selection Tool + Shift +ลาก

เมาส 

สลับเคร่ืองมือระหวาง Magnetic 

Lasso tool กับ Lasso tool 

Alt + ลากเมาส Option + ลากเมาส 

สลับเคร่ืองมือระหวาง Magnetic 

Lasso tool กับ Polygonal 

Lasso 

Alt + Click Alt + Click 

Move copy of selection Move tool + Alt + ลากเมาส Move tool + Option + ลากเมาส 

ยาย selection ทีละ 1 pixel Selection tool + ลูกศร Selection tool + ลูกศร 
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หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-17 คียลัดคำสั่ง View 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Zoom in Ctrl + (+ +) Command + (+ +) 

Zoom out Ctrl + (+ -) Command + (+ -) 

Fit on Screen Ctrl + 0 Command + 0 

ขยาย 100% Double click + Zoom tool 

หรือ Ctrl + 1 

Double click + Zoom tool 

หรือ Command + 1 

Extras Ctrl + H Command + H 

Show 

 Target Path 

 Grid 

 Guides 

 

Shift + Ctrl + H 

Ctrl + ’ 

Ctrl + ; 

 

Shift + Command + H 

Command + ’ 

Command + ; 

Rulers Ctrl + R Command + R 

Snap Shift + Ctrl + ; Shift + Command + ; 

Lock Guides Alt + Ctrl + ; Option + Command + ; 

สลับไปเคร่ืองมือ Zoom In Control + spacebar Command + spacebar 

สลับไปเคร่ืองมือ Zoom Out Alt + spacebar Option + spacebar 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-18 คียลัดคำสั่ง Blending modes  

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Normal Shift + Alt + N Shift + Option + N 

Dissolve Shift + Alt + I Shift + Option + I 

Behind (Brush tool only) Shift + Alt + Q Shift + Option + Q 

Clear (Brush tool only) Shift + Alt + R Shift + Option + R 

Darken Shift + Alt + K Shift + Option + K 

Multiply Shift + Alt + M Shift + Option + M 

Color Burn Shift + Alt + B Shift + Option + B 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

Linear Burn Shift + Alt + A Shift + Option + A 

Lighten Shift + Alt + G Shift + Option + G 

Screen Shift + Alt + S Shift + Option + S 

Color Dodge Shift + Alt + D Shift + Option + D 

Linear Dodge Shift + Alt + W Shift + Option + W 

Overlay Shift + Alt + O Shift + Option + O 

Soft Light Shift + Alt + F Shift + Option + F 

Hard Light Shift + Alt + H Shift + Option + H 

Vivid Light Shift + Alt + V Shift + Option + V 

Linear Light Shift + Alt + J Shift + Option + J 

Pin Light Shift + Alt + Z Shift + Option + Z 

Hard Mix Shift + Alt + L Shift + Option + L 

Difference Shift + Alt + E Shift + Option + E 

Exclusion Shift + Alt + X Shift + Option + X 

Hue Shift + Alt + U Shift + Option + U 

Saturation Shift + Alt + T Shift + Option + T 

Color Shift + Alt + C Shift + Option + C 

Luminosity Shift + Alt + Y Shift + Option + Y 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

ตารางท่ี 3-19 คียลัดคำสั่งอ่ืน ๆ 

คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

เลือก Foreground color จาก 

color picker 

Painting Tool + Shift + Alt + 

คลิกขวา + ลากเมาส 

Painting Tool + Control + 

Option + Command + ลากเมาส 

เลือก Foreground color จาก

ภาพดวยเคร่ืองมือ Eyedropper 

Painting tool + Alt            

หรือ shape tool + Alt 

Painting tool + Option  

หรือ Shape tool + Option 

เลือก Background color Eyedropper tool + Alt-click Eyedropper tool + Option-click 

เติม Foreground color หรือ 

Background color 

Alt + Backspace  

หรือ Control + Backspace 

Option + Delete  

หรือ Command + Delete 
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คำสั่ง คียลัดสำหรับ Windows คียลัดสำหรับ macOS 

สลับระหวางการระบายและการ

ลบดวยแปรงเดียวกัน 

กด ` คางไว กด ` คางไว  

ลดขนาดแปรง [ [ 

เพิ่มขนาดแปรง ] ] 

ลดความแข็งของแปรง { { 

เพิ่มความแข็งของแปรง } } 

หมุน Brush ทีละ 1 องศา ลูกศรซาย (ทวนเข็มนาิกา) 

ลูกศรขวา (ตามเข็มนาิกา) 

ลูกศรซาย (ทวนเข็มนาิกา) 

ลูกศรขวา (ตามเข็มนาิกา) 

หมุน Brush ทีละ 15 องศา Shift + ลูกศรซาย (ทวนเข็ม

นาิกา) 

Shift + ลูกศรขวา (ตามเข็ม

นาิกา) 

Shift + ลูกศรซาย (ทวนเข็มนาิกา) 

Shift + ลูกศรขวา (ตามเข็มนาิกา) 

ปดเอกสารที่เปดอยูทั้งหมด 

ยกเวนเอกสารปจจุบัน 

Ctrl + Alt + P Command + Option + P 

หมายเหตุ. (Default keyboard shortcuts, 2021) 

 

3.6   ขอควรระวังในการปฏิบัติงาน 

1. ตรวจสอบความถูกตองของขอมูล เชน ชื่อกิจกรรม วัน เวลา ชื่อผูเขารวมงาน เปนตน ทุกคร้ังกอนการ

ผลิตภาพกราฟก 

2. ตรวจสอบภาพกราฟกทุกคร้ังกอนการบันทึกภาพเพื่อนำไปใช เชน ตัวสะกดถูกหรือไม ใสเอฟเฟกต

ครบทุกเลเยอรหรือไม สีตัวอักษรตรงตามแบบหรือไม เปนตน 

3. สอบถามการใชเครื ่องสลับสัญญาณภาพจากผูรับผ ิดชอบในการถายทอดสดทุกครั้ง เนื่องจาก

ภาพกราฟกที่ใชกับเครื่องสลับสัญญาณภาพแตละเครื่องไมเหมือนกัน ทำใหตองผลิตภาพกราฟก

แตกตางกันออกไปในแตละเคร่ือง 
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บทที่ 4 

เทคนิคการปฏบิัติงาน 

 คูมือการปฏิบัติงานการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต โดยใชโปรแกรม 

Adobe Photoshop cc ของกลุมงานพัฒนานวัตกรรมและเทคโนโลย ีการศึกษา สำนักวิทยบริการและ

เทคโนโลยีสารสนเทศ ไดอธิบายขั้นตอนการผลิตภาพกราฟกโดยการใชโปรแกรม Adobe Photoshop cc 

โดยผูจัดทำ ไดแบงวิธีการนำเสนอออกเปน 5 ขั้นตอน ดังน้ี 

4.1  การสรางไฟลเอกสารใน Adobe Photoshop cc 

4.2  การผลิตภาพกราฟกภาพพักหนาจอ 

4.3  การผลิตภาพกราฟกแถบชื่องาน 

4.4  การผลิตภาพกราฟกแถบชื่อผูรวมงาน 

4.5  การบันทึกไฟลภาพกราฟก 

4.1    การสรางไฟลเอกสารใน Adobe photoshop cc 

การสรางไฟลเอกสาร เปนการกำหนดขนาดและความละเอียดของชิ ้นงานใหเหมาะกับงานที่จะ

นำไปใช เพราะงานแตละประเภทจะใชขนาดและความละเอียดที่แตกตางกัน สามารถสรางไฟลเอกสารไดโดย

การไปที่ Menu Bar -> File -> New  จะมีหนาตาง Preset ปรากฏขึ้นมา  

 

 

 

 

 

 

 

 

ภาพท่ี 4-31 การต้ังคาไฟลเอกสาร 
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ดานบนของหนาตาง Preset เปนขนาดไฟลที่โปรแกรมกำหนด โดยแบงเปนประเภทตาง ๆ ดังน้ี 

1) Recent คือ แสดงการใชงานไฟลลาสุด สามารถคลิกเปดไฟลไดจากตรงน้ี 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 4-38 หนาตางการต้ังคาไฟลงาน 

ภาพท่ี 4-32 หนาตาง Preset 

ภาพท่ี 4-33 แสดงการใชงานไฟลลาสุด 
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2) Save คือ ไฟลเอกสารที่ไดบันทึกเก็บไว สวนมากจะเปนไฟลเอกสารที่ใชบอยหรือเปนไฟลที่ได

กำหนดคาเอง เพื่อใหสะดวกกับการทำงาน 

 

 

 

 

 

 

 

 

 

3) Photo ใชสำหรับการทำงานกับภาพถาย เปนขนาดของกระดาษสำหรับอัดภาพถาย เชน 

Landscape 4x6, Portrait 5x7 เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-34 ไฟลเอกสารที่ไดบันทึก  

ภาพท่ี 4-35 ขนาดของไฟลเอกสารทีโ่ปรแกรมกำหนดไวในประเภท Photo  
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4) Print ใชกับงานสิ่งพิมพ เปนขนาดสำหรับกระดาษ เชน Letter, Legal, Tabloid, A3, A4, A5, B3, 

B4 เปนตน 

 

 

 

 

 

 

 

 

 

5) Art & Illustration ใชกับงานวาดรูป ศิลปะ ภาพประกอบตางๆ มีขนาด poster, Postcard, 1000 

pixel grid เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-36 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Print 

ภาพท่ี 4-37 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Art & Illustration 
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6) Web ใชกับงานทำเว็บไซตตาง ๆ มีหลายรูปแบบใหเลือก เชน Web Most Common, Web 

Medium, Desktop HD Design เปนตน 

 

 

 

 

 

 

 

 

 

7) Mobile ใชสำหรับการต้ังคาขนาดหนาจอมือถือ เชน iPhone, iPad, Android, Microsoft Surface, 

Mobile Design เปนตน 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-38 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Web 

ภาพท่ี 4-39 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Mobile 
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8) Film & Video ใหสำหรับการทำงานกับไฟลวิดีโอ เชน HDTV, DVCPRO HD, NTSC DV, FILM (4K) 

เปนตน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ทางดานขวาของหนาตาง Preset จะเปนรายละเอียดการกำหนดคาตาง ๆ ของไฟลเอกสาร มี

รายละเอียดดังน้ี (Create documents, 2019) 

1) Untitled-1 คือ ชองต้ังชื่อไฟลเอกสาร  

2) Width คือ ความกวางของไฟลเอกสาร มีหนวยเปน pixel, Inches, Centimeters, 

Millimeters, Point และ Picas  

3) Height คือ ความยาวของไฟลเอกสาร มีหนวยเปน pixel, Inches, Centimeters, Millimeters 

Point และ Picas  

4) Orientation คือ ต้ังคาไฟลเอกสารใหเปนแนวต้ังหรือแนวนอน โดยการสลับคาความกวางและ

ความสูงที่ไดกำหนดไว  

ภาพท่ี 4-41 รูปแบบตาง ๆ ที่โปรแกรมกำหนด 

ภาพท่ี 4-40 ขนาดของไฟลเอกสารที่โปรแกรมกำหนดไวในประเภท Film & Video 
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5) Resolution คือ ความละเอียดของไฟลเอกสาร สามารถกำหนดขนาดและหนวยไดเอง โดยหนวย

จะม ีPixel/Inches และ Pixel/Centimeters ใชสำหรับงานสิ่งพิมพ 

6) Color Mode คือ โหมดสีของไฟลเอกสาร ประกอบไปดวย โหมดสี Bitmap, Grayscale, RGB 

Color, CMYK Color และ Lab Color 

7) Background Contents คือ สีพื้นหลังของไฟลเอกสาร ประกอบไปดวย Black, White, 

Background Color, Transparent และ Custom 

8) Advanced options คือ การต้ังคาโปรไฟลสีและอัตราสวนพิกเซลของเอกสาร  

ในการสรางไฟลเอกสาร สามารถเลือกขนาดและความละเอียดของไฟลเอกสารตามที่โปรแกรม

กำหนดมาให หรือกำหนดคาเองไดเชนกัน เมื่อกำหนดขนาดไฟลเอกสารแลว ใหคลิกปุม Create เพื่อสรางไฟล

เอกสาร  

 

 

 

 

 

 

  

 

 

 

 

 

 

1 ต้ังชื่อไฟลเอกสาร 

2ความกวางของไฟลเอกสาร 

5 ความละเอียดของไฟลเอกสาร 

3 ความยาวของไฟลเอกสาร 

6 โหมดสีของไฟลเอกสาร 

7 สีพื้นหลังของไฟลเอกสาร 

8 ต้ังคาโปรไฟลสีและอัตราสวน

พิกเซลของเอกสาร 

4 
ต้ังคาไฟลเอกสารใหเปนแนวต้ัง

หรือแนวนอน 

ภาพท่ี 4-42 หนาตาง Preset Detail 

9 คลิกปุม Create เพื่อสราง

ไฟลเอกสาร 
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4.2 การผลิตกราฟกภาพพักหนาจอ 

 กราฟกภาพพักหนาจอเปนกราฟกที่ใชบอกชื่องาน ว ัน เวลาและสถานที ่จ ัดงาน ใช ก อนการ

ถายทอดสด ชวงพกัระหวางการถายทอดสดและหลังจบการถายทอดสด สำหรับประชาสัมพันธกิจกรรมตาง ๆ 

ของทางมหาวิทยาลัย โดยในคูมือการจัดทำเลมนี้ไดนำเสนอการจัดทำกราฟกภาพพักหนาจอในงานซอมรับ

ปริญญา สำหรับขั้นตอนในการผลิตกราฟกภาพพักหนาจอโดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำได

นำเสนอวิธีการผลิตกราฟกภาพพักหนาจอ โดยมีขั้นตอนวิธีการดังตอไปน้ี 

1. เปดโปรแกรม Adobe Photoshop cc 

 

 

 

 

 

 

ภาพท่ี 4-43 ไฟลเอกสารที่สรางสำเร็จ 
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ภาพท่ี 4-45 หนาจอเมื่อโปรแกรม Adobe Photoshop cc เปดใชงาน 

 

ภาพท่ี 4-44 วิธีเปดโปรแกรม Adobe Photoshop cc 

1 

คลิกที่แถบเมนู Start -> 

Adobe Photoshop cc  
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2. สรางไฟลเอกสาร 

 

 

 

  

 

 

 

 

3. เน่ืองจากเปนการทำงานกับเคร่ืองสลับสัญญาณภาพและเสียงที่มีคุณสมบัติเปน HDTV 1080p 

ใหต้ังคาดังน้ี  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-46 การสรางไฟลเอกสาร 

คลิกที่ Menu Bar -> 

File -> New 

2.1 

เลือก Film & Movie 

3.1 

3.2 เลือก HDTV 1080p 1920 x 1080 px @ 72 ppi 

ภาพท่ี 4-47 การต้ังคาไฟลเอกสาร  
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ภาพท่ี 4-48 การกำหนดภาพพื้นหลังของไฟลเอกสาร 

3.3 เลือก Background Contents เปน Transparent 

ภาพท่ี 4-49 การต้ังชื่อไฟลเอกสาร 

ต้ังชื่อไฟลเอกสาร  ในที่น้ีต้ังชื่อวา Background  3.4 

3.5 

คลิกปุม Create 

เพื่อสรางไฟลเอกสาร 
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4. นำไฟลรูปเขาสูโปรแกรม  

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-50 หนาจอแสดงไฟลเอกสาร Background  ที่ไดสรางไว 

ภาพท่ี 4-51 หนาจอแสดงการเปดไฟลรูป 

4.1 

คลิกที่ File -> Open  
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ภาพท่ี 4-52 หนาจอแสดงการเลือกไฟลรูป 

4.3 

คลิก Open  ไฟลรูปจะ

ปรากฏในขึ้นมาในโปรแกรม 

4.2 คลิกเลือกไฟลรูปที่ตองการ 

ภาพท่ี 4-53 รูปภาพที่เลือกในไฟลเอกสาร Background 
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5. คัดลอกไฟลรูปที่เปด นำไปวางไวในไฟลเอกสาร Background โดยมีขั้นตอนดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-54 คลิกเลือก Layer รูปภาพ ใน Layer Panel 

 

5.1 ไปที่ Layer Panel คลิก Layer รูปภาพที่ตองการ Copy หากที่ Layer มีรูป

กุญแจล็อกใหทำการปลดล็อก Layer โดยการคลิกที่รูปกุญแจหน่ึงคร้ัง 

ภาพท่ี 4-55 คัดลอกรูปภาพโดยใช Menu Edit 

5.2 

ไปที่ Menu Bar -> Edit -> Copy หรือใช 

คีย ล ัด (Shortcut) โดยการกด Ctrl+C ที่

คียบอรดเพ ื่อทำการคัดลอก Layer ไฟล

รูปภาพ 
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ภาพท่ี 4-56 เลือกไฟลเอกสารที่ตองการวางรูปที่คัดลอกมา 

5.3 เลือกไฟลเอกสารที่ตองการวางรูป โดยการคลิกที่ชื่อไฟลเอกสาร 

ภาพท่ี 4-57 วาง Layer ที่ Copy มา โดยใช Menu -> Edit 

5.4 

วางไฟลรูปภาพดวยคำสั่ง  Menu Bar -> 

Edit -> Paste หรือใช คียลัด (Shortcut)  

โดยการกด Ctrl+V 

 



72 
 

 

 

 

 

 

 

 

 

 

 

 

 

6. จัดวางรูปภาพ โดยใช คำสั ่ ง Edit -> Transform และ Move Tool ในการย อขยายและ

เคลื่อนยายรูปภาพ โดยใหจุดเดนของภาพคือมือที่กำลังรับใบปริญญาอยูดานบนของ Artboard 

เน่ืองจากตองเหลือพื้นที่ดานลางสำหรับขอความ 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-58 ไฟลรูปภาพในไฟลเอกสาร Background 

ภาพท่ี 4-60 การเลือก Move Tool ภาพท่ี 4-59 ใชคำสั่ง Edit -> Transform  

Move Tool 

คำสั่ง Edit -> 

Transform 
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7. ใส Filter Gaussian blur เพื่อลดความคมชัดของรูป  

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-61 การจัดวางรูปภาพใหเหมาะสมกับขนาดของพื้นที่ 

7.1 

ใชคำสั่งที่ Menu Bar -> Filter -> 

Blur -> Gaussian Blur  

ภาพท่ี 4-62 ใส Filter Gaussian blur 
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จะปรากฏหนาตาง Gaussian Blur กำหนดคาดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.3 

7.2 

ภาพท่ี 4-63 กำหนดคา Radius ใน Filter Gaussian blur 

Radius เปน 4.5 Pixels  

คลิก OK 

ภาพท่ี 4-64 รูปภาพที่ใส Filter Gaussian blur 
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8. สรางขอความ โดยแบงขอความออกเปน 2 สวน คือ ชื่องานและรายละเอียดของงาน 

กำหนดใหแบบตัวอักษรที่ใช คือ DB Chidlom X และตัวอักษรเปนสีขาว ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

8.1 

คลิกเลือก Horizontal Type Tool 

ภาพท่ี 4-65 Horizontal Type Tool ที ่Toolbox 

กำหนดคาของขอความชื่องานที่ Option bar  ดังน้ี เลือก DB Chidlom X สไตล Bold ขนาด

ตัวอักษร 80 pt  ความคมของตัวอักษรเลือก Strong กำหนดใหรูปแบบของตัวอักษรอยูตรง

กลางและตัวอักษรมีสีขาว 

8.2 

ภาพท่ี 4-66 Option bar กำหนดรายละเอียดของตัวอักษรกลุมชื่องาน 
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  จัดแตงขอความใหเหมาะสมสวยงามโดยใช Move Tool และ Character Panel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-68 ยายขอความโดยใช 

                Move Tool 

8.4 ยายขอความโดยใช   

Move Tool  

จัดแตงขอความใหสวยงามเหมาะสม

โดยใช Character Panel 8.4 

ภาพท่ี 4-69 จัดแตงขอความโดยใช                                      

                 Character Panel  

ภาพท่ี 4-67 ขอความที่พิมพลงไป 

คลิกที่ Artboard หน่ึงคร้ัง แลวพิมพขอความ ซอมยอยรวม 

พิธีพระราชทานปริญญาบัตร ประจำปการศึกษา ๒๕๖๑ 
8.3 
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ภาพท่ี 4-72 เรียกใชคำสั่ง Effect Stroke  

                ที ่Layer Panel  

 

 

 

 

 

 

 

 

 

 

 

 

 

ใสขอบของตัวอักษรใหเปนสีมวง โดยการกำหนดคา Stroke ที่ Layer Style สามารถเรียก 

Layer Style ได 2 วิธี ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-70 ขอความที่จัดแตงสำเร็จ 

ภาพท่ี 4-71 เรียกใชคำสั่ง Effect Stroke  

                ที ่Menu Layer    

8.5 
ใชคำสั่งที่ Menu Bar -> Layer -> 

Layer Style -> Stroke 

หรือดับเบิ้ลคลิกที่ Layer ขอความที่

ตองการใสขอบตัวอักษร ใน Layer 

Panel 

8.5 
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จะปรากฏหนาตาง Layer Style กำหนดคาดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

กำหนด size เปน 4 px  

Position เปน Outside 

Color เลือกสีมวง 

8.7 8.6 คลิกเลือก Stroke 

8.8 

คลิก OK 

ภาพท่ี 4-73 กำหนดคาในหัวขอ Stroke 

ภาพท่ี 4-74 ขอความชื่องานที่จัดทำสำเร็จ  
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เมื่อจัดทำขอความชื่องานสำเร็จ ขั้นตอนตอมาคือ ทำขอความรายละเอียดของงาน โดยคลิก

เลือก Horizontal Type Tool ที่ Toolbox จากน้ันกำหนดรายละเอียดของตัวอักษรที่ Option bar 

ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-76 ขอความรายละเอียดของงาน 

 

ภาพท่ี 4-75 Option bar กำหนดรายละเอียดของกลุมขอความรายละเอียดของงาน 

รูปแบบของตัวอักษร เลือก DB Chidlom X สไตล Medium ขนาดตัวอักษร 56 pt ความคม

ของตัวอักษรเลือก Strong กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 

8.9 

8.10 
คลิกท่ี Artboard หน่ึงครั้ง พิมพขอความ วันพฤหัสบดีท่ี ๑๕ สิงหาคม ๒๕๖๓ 

ณ หองประชุมชั้น 3 อาคารมงคลอาภา คณะบริหารธุรก ิจ มหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร  ทำการปรับแตงขอความใหเหมาะสมโดยใช 

Move Tool และ Character Panel 
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ใสขอบของตัวอักษรใหเปนสีมวง โดยกำหนดคา Stroke ที่ Layer Style ดังน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.12 

8.13 

8.11 

กำหนด size เปน 3 px  

Position เปน Outside 

Color เลือกสีมวง 
คลิกเลือก Stroke 

คลิก OK 

ภาพท่ี 4-77 กำหนดคาในหัวขอ Stroke 

ภาพท่ี 4-78 ขอความรายละเอียดของงานที่จัดแตงสำเร็จ 
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ภาพท่ี 4-79 ไฟลภาพพักหนาจอที่จัดทำสำเร็จ 

ภาพท่ี 4-80 ตัวอยางภาพพักหนาจอพิธีไหวครูในการถายทอดสดผาน Facebook live 
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4.3 การผลิตภาพกราฟกแถบชื่องาน 

กราฟกแถบชื่องานสามารถออกแบบไดตามลักษณะของกิจกรรม โดยคูมือการจัดทำเลมน้ีไดนำเสนอ

การจัดทำกราฟกแถบชื่องาน ในงานซอมยอยรวม พิธีพระราชทานปริญญาบัตร ดังน้ันกราฟกจึงมีลักษณะที่

เปนทางการ เรียบงาย โดยการใชสี่เหลี่ยมเปยกปูน สีที่ใชคือสีมวง สีประจำมหาวิทยาลัย แบบตัวอักษรที่ใชคือ 

DB Chidlom แบบตัวอักษรประจำมหาวิทยาลัย และสีตัวอักษรเปนสีขาว ทำใหอานงาย สบายสายตา สำหรับ

ขั้นตอนในการผลิตกราฟกแถบชื่องานโดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำไดนำเสนอวิธีการผลิต

กราฟกชื่องาน โดยมีขั้นตอนวิธีการดังตอไปน้ี  

1. เปดโปรแกรม Adobe Photoshop ขั้นตอนนี้สามารถเลือกไดวาจะสรางไฟลเอกสารใหม

หรือจะเปดไฟลเอกสารที ่ไดทำการบันทึกเอาไว  ในที ่นี ้จะขอเล ือกเปดไฟลเอกสาร 

Background ที่ไดทำภาพพักหนาจอไว 

 

 

 

 

 

ภาพท่ี 4-81 ตัวอยางภาพพักหนาจองานปจฉิมนิเทศนักศึกษาในการถายทอดสดผาน Facebook live  
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ภาพท่ี 4-82 เปดไฟลเอกสารที่ไดบันทึกไวโดยคำสั่ง Open 

1.1 

ไปที่ Menu Bar -> Open   

ภาพท่ี 4-83 เลือกไฟลที่ตองการเปด 

1.3 

1.2 

เลือกไฟลเอกสารที่ตองการเปด 

คลิก Open 
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2. สรางสี่เหลียมผืนผาขึ้นมาโดยใช Rectangle Tool  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

คลิก Rectangle Tool          

ที่ Toolbox 

ภาพท่ี 4-84 ไฟลเอกสารที่ไดบันทึกไว 

2.1 

ภาพท่ี 4-85  Rectangle Tool ที่ Toolbox 
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คลิกที่ Artboard  หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดไวที่ Option bar  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-86 กำหนดคาของแถบชื่อที่ Option bar 

2.2 กำหนดคา Fill เปนสีมวง ความกวางของสี่เหลี่ยม = 1100 px ความสูง = 120 px   

ภาพท่ี 4-88 สี่เหลี่ยมผืนผาที่สรางสำเร็จ 

ภาพท่ี 4-87 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

2.4 

คลิกเลือก From Center 

จากน้ันคลิกปุม OK 
2.3 

หากขนาดไมถกูตอง 

สามารถแกไขไดใน

หนาตางน้ี 
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ภาพท่ี 4-89 Move Tool สำหรับเคลื่อนยาย 

2.5 

ใช Move Tool เลื่อน

สี่เหลี่ยมผืนผาลงมาใกลกับเสน

ไกดแนวนอนเสนที่ 3 

ภาพท่ี 4-90 เสนไกดแนวนอนเสนที่ 3 

เสนไกดแนวนอนเสนที่ 3 
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ภาพท่ี 4-91 สี่เหลี่ยมที่ยายลงมาดานลาง 

ภาพท่ี 4-92 คำสั่ง Skew ที่ Menu Bar -> Edit 

2.6 

ใชคำสั่ง Menu Bar -> Edit -> 

Transform -> Skew 

ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 
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3.  พิมพขอความชื่องาน กำหนดใหตัวอักษรที่ใช คือ DB Chidlom X  สีตัวอักษรคือสีขาว  

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-94 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ 

2.7 

ภาพท่ี 4-93 ปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 

คลิกคางที่จุดตรงกลางดานบน เลื ่อนไปทางขวา

จนไดองศาที่ตองการ จากน้ันกด Enter หน่ึงคร้ัง 

 

3.1 

คลิกเลือก 

Horizontal Type Tool 

ภาพท่ี 4-95 Horizontal Type Tool 
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ภาพท่ี 4-96 Option bar กำหนดรายละเอียดของตัวอักษร 

3.2 
กำหนดรายละเอียดดังน้ี เลือก DB Chidlom X สไตล Bold ขนาดตัวอักษร 46 pt 

กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 

ภาพท่ี 4-97 ขอความที่พิมพลงไป 

ยายขอความโดยใช Move Tool  3.3 3.3 จัดแตงขอความใหสวยงามเหมาะสม

โดยใช Character Panel 

ภาพท่ี 4-98 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool  และ Character Panel  
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ภาพท่ี 4-99 ขอความที่จัดแตงสำเร็จ 

ภาพท่ี 4-101 ตัวอยางกราฟกแถบชื่องานในการสัมมนาผาน Facebook live 

ภาพท่ี 4-100 ตัวอยางกราฟกแถบชื่อการบรรยาย กิจกรรมปฐมนิเทศนักศึกษา          

                  ในการถายทอดสดผาน Facebook live 
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4.4 การผลิตภาพกราฟกแถบชื่อผูรวมงาน 

  กราฟกแถบชื่อผูรวมงานจะเปนกราฟกบอกชื่อของผูดำเนินงานในชวงตาง ๆ เชน พิธีกร ผู

ดำเนินรายการ ประธานในงานหรือวิทยากรผูใหความรู เพื่อบอกกับผูรับชมใหทราบวาเปนใครและเปนการให

เกียรติแกบุคคลนั้น ๆ  กราฟกแถบชื่อสวนมากจะมีลักษณะเหมือนกับกราฟกแถบชื่องานหรืออาจมีลักษณะ

แตกตางกันไมมาก เพื่อใหลักษณะของกราฟกมีความเปนอันหนึ่งอันเดียวกัน โดยในคูมือการจัดทำเลมน้ี         

ไดนำเสนอการจัดทำกราฟกแถบชื่อผูรวมงาน ในงานซอมยอยรวม พิธีพระราชทานปริญญาบัตร ดังน้ันกราฟก

จึงมีลักษณะเดียวกับกราฟกแถบชื่องาน คือ มีลักษณะเปนสี่เหลี่ยมเปยกปูนสีมวง แตจะมีแถบสีขาวเล็ก ๆ อยู

ชวงลางเพือ่แบงขอความออกเปนสองสวน คือ สวนของชื่อ - นามสกุลของผูรวมงานและสวนของตำแหนง

หนาที่ แบบตัวอักษรที่ใชคือ DB Chidlom สีตัวอักษรเปนสีขาว สำหรับขั้นตอนในการผลิตกราฟกแถบชื่องาน

โดยใชโปรแกรม Adobe Photoshop cc ผูจัดทำไดไดนำเสนอวิธีการผลิตกราฟกชื่องาน โดยมีขั้นตอนวิธีการ

ดังตอไปน้ี  

1. สรางสี่เหลี่ยมผืนผาขึ้นมา 2 รูป แบงเปนสี่เหลี่ยมสีมวงและสี่เหลีย่มสีขาวอยางละ 1 รูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.1 

สรางสี่เหลี่ยมสีมวงโดยใช 

Rectangle Tool ที่ Toolbox 

ภาพท่ี 4-102 Rectangle Tool ที่ Toolbox 
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คลิกที่ Artboard หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดขนาดไวที่ Option bar  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-103 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีมวง 

กำหนดคาให Fill เปนสีมวง ความกวางของสี่เหลี่ยม = 1100 pixel ความสูง = 140 pixel 1.2 

ภาพท่ี 4-105 สี่เหลี่ยมสีมวงที่สรางสำเร็จ 

ภาพท่ี 4-104 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

1.4 

คลิกเลือก      

From Center 

จากน้ันคลิกปุม OK 

1.3 

หากขนาดไมถูกตอง 

สามารถแกไขไดใน

หนาตางน้ี 
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คลิกที่ Artboard หน่ึงคร้ัง จะปรากฏหนาตาง Create Rectangle ในหนาตางบอกขนาด

ของความกวางและความสูงที่ไดกำหนดไวที่ Option bar 

 

 

 

 

 

 

 

 

ภาพท่ี 4-107 Option bar กำหนดรายละเอียดของสี่เหลี่ยมสีขาว 

กำหนดคาให Fill เปนสีขาว ความกวางของสี่เหลี่ยม = 1100 pixel ความสูง = 10 pixel 1.6 

ภาพท่ี 4-108 หนาตางแสดงขนาดของแถบขอความที่ตองการสราง 

 

1.8 

คลิกเลือก From Center 

จากน้ันคลิกปุม OK 

1.7 

หากขนาดไมถูกตอง 

สามารถแกไขไดใน

หนาตางน้ี 

ภาพท่ี 4-106 Rectangle Tool ที่ Toolbox 

1.5 

สรางสี่เหลี่ยมสีขาวโดยใช 

Rectangle Tool ที่ Toolbox 



94 
 

 

 

 

 

 

 

 

 

 

 

 

 

2. เลื่อนสี่เหลี่ยมสีขาวลงมาแบงสี่เหลี่ยมสมีวงออกเปน 2 สวน โดยใหดานบนมีพื้นที่เยอะกวา

ดานลาง เพื่อแบงชองระหวางชื่อ – นามสกุลและตำแหนงผูรวมงาน  

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-109 สี่เหลี่ยมสีขาวที่สรางสำเร็จ 

ภาพท่ี 4-110 สี่เหลี่ยมสีขาวและสีมวง 

ภาพท่ี 4-111 Move Tool สำหรับเคลื่อนยายสี่เหลี่ยม 

2.1 

ใช Move Tool         

ในการเคลื่อนยาย 
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ภาพท่ี 4-112 การเคลื่อนยายสี่เหลี่ยมสีขาว 

2.2 

เลือก Layer สี่เหลี่ยมสีขาวและสมีวงเพื่อทำ

การปรับรูปทรงใหเปนสี่เหลี่ยมเปยกปูน 

ภาพท่ี 4-113 เลือก Layer สี่เหลี่ยมที่ตองการปรับรูปทรง 

ภาพท่ี 4-114 คำสั่ง Skew ที่ Menu Bar -> Edit 

ใชคำสั่ง Menu Bar -> Edit -> 

Transform -> Skew เพื่อปรับรูปทรง 

2.3 
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3. พิมพขอความชื่อหรือตำแหนงหนาที่ของผูรวมงาน ใหชื่อและนามสกุลอยูในชองสีมวงดานบน 

ตำแหนงและหนาที่อยูที่ชองสีมวงดานลาง กำหนดใหตัวอักษรที่ใช คือ DB Chidlom X  Style 

Bold สีขาว 

 

 

 

 

 

 

 

 

ภาพท่ี 4-116 สี่เหลี่ยมเปยกปูนที่สรางสำเร็จ 

ภาพท่ี 4-115 คลิกจุดตรงกลางเพื่อปรับรูปทรงของสี่เหลี่ยมผืนผาใหเปนสี่เหลี่ยมเปยกปูน 

2.4 
คลิกคางที่จุดตรงกลางดานบน เลื่อนไปทางขวา

จนไดองศาที่ตองการ จากน้ันกด Enter หน่ึงคร้ัง 

3.1 

คลิกเลือก 

Horizontal Type Tool 

ภาพท่ี 4-117 Horizontal Type Tool 
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เลือก Horizontal Type Tool อีกคร้ังเพื่อสรางขอความตำแหนงหรือหนาที่ของผูรวมงาน 

โดยกำหนดรายละเอียดของตัวอักษรที่ Option bar  ดังน้ี 

 

 

 

 

 

 

 

 

ภาพท่ี 4-118 Option bar กำหนดรายละเอียดของตัวอักษร 

กำหนดรายละเอียดของตัวอักษร ดังน้ี รูปแบบของตัวอักษร เลือก DB Chidlom X 

สไตล Bold ขนาดตัวอักษร 65 pt 
3.2 

ภาพท่ี 4-119 ชื่อและนามสกุลของผูรวมงาน 

พิมพชื่อ-นามสกุลของผูรวมงาน  3.3 

รูปแบบของตัวอักษร เลือก DB Chidlom X สไตล Bold ขนาดตัวอักษร 42 pt 

กำหนดใหรูปแบบของตัวอักษรอยูตรงกลางและใหตัวอักษรมีสีขาว 
3.4 

ภาพท่ี 4-120 Option bar กำหนดรายละเอียดของตัวอักษร 
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ภาพท่ี 4-121 พิมพตำแหนงหรือหนาที่ของผูรวมงาน 

พิมพตำแหนงหรือหนาที่ของผูรวมงาน 3.5 

ยายขอความโดยใช Move Tool  3.6 จัดแตงขอความใหสวยงามเหมาะสมโดย

ใช Character Panel 
3.6 

ภาพท่ี 4-122 ยายและจัดแตงขอความใหเหมาะสมดวย Move Tool และ Character Panel  

ภาพท่ี 4-123 กราฟกแถบชื่อผูรวมงานที่จัดทำสำเร็จ 
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ภาพท่ี 4-124 ตัวอยางกราฟกแถบชื่อผูดำเนินรายการ กิจกรรมปฐมนิเทศนักศึกษา     

                  ในการถายทอดสดผาน Facebook live 

 

ภาพท่ี 4-125 ตัวอยางกราฟกแถบชื่อวิทยากรในการสัมมนาผาน Facebook live 
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4.5 การบันทึกไฟลภาพกราฟก 

 เมื่อจัดทำภาพกราฟกสำเร็จ ใหทำการบันทึกไฟลภาพกราฟกเพื่อนำไปใชงาน โดยขั้นตอนในการ

บันทึกไฟลภาพมีดังน้ี 

1. การบันทึกไฟลภาพกราฟกสำหรับภาพพักหนาจอ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-126 คำสั่ง save as ที่ Menu Bar -> File 

1.1 

ไปท ี ่  Menu Bar -> File -> Save 

As จะปรากฏหนาตาง Save As 

ภาพท่ี 4-127 ต้ังชื่อไฟลภาพ 

1.2 

ตั้งชื ่อไฟลเปนภาษาอังกฤษเพื่อ

ปองกันขอผิดพลาดในเรื่องภาษา

ของเครื่องสลับสัญญาณภาพและ

เสียง ในตัวอยางนี้ขอตั ้งช ื ่ อวา 

Fashion 



101 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-128 เลือกนามสกุลไฟล 

1.3 

ในชอง Save as type ให เล ือก

เปน TIFF (*.TIF/*.TIFF) 

ภาพท่ี 4-129 เลือกสถานที่จัดเก็บไฟล 

1.5

1.4

เลือกสถานที่

จัดเก็บไฟล 

คลิก Save  
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จะปรากฏหนาตาง TIFF Option 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-130 หนาตาง TIFF Option 

1.6 

คลิก OK  

ภาพท่ี 4-131 ภาพพักหนาจอที่บันทึกสำเร็จ 
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2. การบันทึกไฟลภาพกราฟกสำหรับแถบชื่องานและแถบชื่อผูรวมงาน 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพท่ี 4-132 คำสั่ง save as ที่ Menu Bar -> File 

2.1 

ไปที่ Menu Bar -> File -> Save As 

ภาพท่ี 4-133 ต้ังชื่อไฟลภาพและนามสกุลของไฟล 

 

2.2 

ต้ังชื่อไฟลภาพและเลือก

นามสกุลไฟลเปน TIFF 

(*.TIF/*.TIFF) 
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ภาพท่ี 4-134 เลือกสถานที่จัดเก็บไฟล 

2.4 

2.3 

เลือกสถานที่

จัดเก็บไฟล 

คลิก Save  

ภาพท่ี 4-135 หนาตาง TIFF Option 

 

2.6 คลิก OK  

คลิกเลือก Save Transparency เพื่อบันทึกแบบพื้นหลังโปรงใส  

 

2.5 

จะปรากฏหนาตาง TIFF Option 
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4.6 การประเมินและติดตามผลงาน 

 เมื่อผลิตกราฟกสำหรับการถายทอดสดสำเร็จ จะนำเสนอกราฟกตอหัวหนางานเพื่อพิจารณาอนุมัตินำ

ภาพกราฟกเขาเคร่ืองสลับสัญญาณภาพและเสียง เตรียมพรอมสำหรับการถายทอดสดผานอินเทอรเน็ตตอไป 

และหลังจากการถายทอดสดผานระบบอินเทอรเน็ตเสร็จสิ้น จะมีการประชุมสรุปผลการดำเนินงานเพื่อหา

ขอบกพรองและดำเนินการแกไขในคร้ังถัดไป 

 

 

ภาพท่ี 4-136 แถบชื่อรายการที่บันทึกสำเร็จ 
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บทที่ 5 

ปญหา อุปสรรคและขอเสนอแนะ 

   ในการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต กลุมพัฒนานวัตกรรมและเทคโนโลยี

การศึกษา สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ผูจัดทำคูมือ

การผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ตไดทำการรวบรวมปญหา อุปสรรคและแนว

ทางการแกไขปญหาจากการปฏิบัติงานพรอมทั้งขอเสนอแนะ โดยมีขอสรุปดังน้ี  

5.1 ปญหาอุปสรรค 

   5.1.1 ปญหาการปฏิบัติงานดานการรวบรวมขอมูล  

  1)  ปญหาการติดตอขอดำเนินการถายทอดสดอยางกะทันหัน 

  2)  ปญหาผูจัดงานไมไดใหรายละเอียดงานที่ชัดเจน 

  3)  ปญหาผูจัดงานเปลี่ยนแปลงรายละเอียดของงานโดยไมแจงใหทราบ 

 5.1.2 ปญหาการปฏิบัติงานดานการผลิตภาพกราฟก 

  1) ปญหาการใชงานโปรแกรม Adobe Photoshop แลวหนาจอคาง ไมสามารถทำงานได 

  2) ปญหาเคร่ืองมือหายไปจาก Toolbar 

  3) ปญหาการบันทึกไฟลสำหรับเคร่ืองสลับสัญญาณภาพและเสียงที่แตกตางกัน 

 5.1.3 ปญหาการปฏิบัติงานดานอุปกรณการทำงาน 

1) ปญหาไมปรากฏ Flash Drive ในเคร่ืองสลับสัญญาณภาพและเสียง 
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5.2 แนวทางการแกไขปญหา  

 

ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ปญหาผูจัดงานติดตอขอดำเนินการถายทอดสด

อยางกะทันหัน 

มีการติดตอขอใหดำเนินการถายทอดสดอยาง

กะทันหัน ทำใหไมสามารถรวบรวมขอมูลไดทัน และ

ทำใหการผลิตภาพกราฟกเกิดความผ ิดพลาดใน

รายละเอียดของกราฟกชื่อผูรวมงานได 

 

 

 ติดตอประสานงานเจาหนาที่ที ่รับผิดชอบ

เพื่อขอขอมูลและทำการตรวจสอบขอมูล 2 รอบทุก

คร้ังกอนการผลิตกราฟก 

2) ปญหาผูจัดงานไมไดใหรายละเอียดงานท่ีชัดเจน 

ผูจัดงานไมไดแจงรายละเอียดที่นอกเหนือจากชื่อ

งานใหทราบ เชน รายละเอียดของผูเขารวมงาน ชื่อ

ตำแหนง เปนตน ทำใหบางคร้ังไมสามารถผลิตกราฟก

ไดครบ 

    

  ติดตอกับเจาหนาที ่ประสานงานเพื ่อขอ

รายละเอียดตาง ๆ ทุกคร้ัง เพื่อใหไดขอมูลที่ถูกตอง 

ครบถวน 

3) ปญหาการเปลี่ยนแปลงรายละเอียดของงานโดย

ไมแจงใหทราบ 

ผูจัดงานไมไดแจงการเปลี่ยนแปลงรายละเอียดให

ทราบ เชน มีการเปลี่ยนแปลงผูดำเนินรายการ หรือ

เปลี่ยนประธานในพิธี ทำใหกราฟกที่จัดทำไมสามารถ

นำขึ้นถายทอดสดได  

 

     

 

 ตรวจสอบขอม ูลกับผูจ ัดงานตั ้ งแต  การ

ประสานงานคร้ังแรกจนถึงกอนการถายทอดสด เพื่อ

ตรวจสอบรายละเอียดของขอมูลใหตรงกันอยูเสมอ 

 

 

 

 

 

 

 

ตารางท่ี 5-20 ปญหาการปฏิบัติงานดานการรวบรวมขอมูล 
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ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ป ญหาการใช  ง านโปรแกรม Adobe 

Photoshop แลวหนาจอคาง ไมสามารถ

ทำงานได 

 เ ม ื ่ อ เป  ด ใ ช  ง านโปรแกรม  Adobe 

Photoshop แลวหนาจอคาง ไมสามารถทำงาน

ตอได หรือกำลังใชงานโปรแกรมแตไมสามารถ

ทำงานตอได หนาจอเบลอ มีสัญลักษณวงกลมวิ่ง

วนไปมา 

 

 

 

 

 

 

 

 

  

 

 

 ใหทำการกดที่คียบอรดของคอมพิวเตอรพรอม

กัน ดังนี ้   Ctrl + Alt + Delete หนาจอแสดงภาพจะ

ปรากฏคำสั่ง เลือก Task Manager หนาตางของ Task 

Manager จะปรากฏขึ ้น หนาตางจะแสดงสถานะการ

ทำงานของโปรแกรมตาง ๆ ที ่ไดเป ดไว  ให ดูท ี ่แถบ

โปรแกรม Adobe Photoshop ว าแถบสถานะข อง

โปรแกรมมีการตอบสนองหรือไม หากมีการตอบสนอง ให

รอเน่ืองจากโปรแกรมกำลังทำงาน แตถาหากโปรแกรมไม

มีการตอบสนอง โดยมีคำวา Not Responding ปรากฏ

ขึ ้น ให คล ิกเมาสเล ือกโปรแกรม Adobe Photoshop 

แลวคลิก End task ที่มุมลางซาย เพื่อออกจากโปรแกรม 

แลวใหเปดโปรแกรมอีกคร้ังหรือรีสตารทเคร่ืองกอนเปดใช

โปรแกรม Adobe Photoshop 

2) ปญหาเคร่ืองมือหายไปจากหนาจอ 

 ในการใช โปรแกรมบางครั ้งอาจไปกด

โดนปุมคียล ัดทำใหเครื่องม ือหายไป หรือเปด

โปรแกรมแลวเคร่ืองมือหายไปจากหนาจอ ทำให

ไมสามารถทำงานได 

 

 

 

 ทำการคืนคาเริ ่มตนของแถบเครื่องมือ โดยไปที่ 

Menu Bar เลือก Edit -> Toolbar -> Restore Defaults 

 หรือบางคร้ังเกิดจากการเลือกใช Workspace ไม

ตรงกับงานใหทำการรีเซ็ตหรือสลับ Workspace โดยไปที่ 

Menu Bar เ ล ื อก  Window -> Workspace - > เ ล ื อก 

Essentials (Default) หรือ Reset Essentials 

3) ปญหาการบันทึกไฟลสำหรับเครื่องสลับ

สัญญาณภาพและเสียงท่ีแตกตางกัน 

 เนื่องเครื่องสลับสัญญาณภาพและเสียง

แตละเครื่องที่ใช มีการทำงานกับภาพกราฟกที่

แตกตางกัน ทำใหขั ้นตอนการผลิตแตกตางกัน

 

  

 สอบถามการใชเคร่ืองสลับสัญญาณภาพและเสียง

จากผูรับผิดชอบในการถายทอดสดทุกครั้ง เพื่อปองกัน

การจัดทำภาพผิดประเภท 

ตารางท่ี 5-21 ปญหาการปฏิบัติงานดานการผลิตภาพกราฟก 
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ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

ออกไป หากจัดทำผิดประเภทจะไมสามารถใช

งานภาพกราฟกได 
 

 

 

ปญหาและอุปสรรคในการปฏิบัติงาน แนวทางการแกไขปญหา 

1) ปญหาไมปรากฏ Flash Drive ในเคร่ืองสลับ

สัญญาณภาพและเสียง 

 เมื่อเสียบ Flash Drive เพื่อทำการ Import 

ไฟลภาพกราฟกลงเครื่องสลับสัญญาณภาพและ

เส ียง Flash Drive ไม ปรากฎในเครื ่อง ทำใหไม

สามารถ Import ไฟลภาพได 

     

 

 

 Format Flash Drive ด  ว ย เ ค ร ื ่ อ ง ส ลั บ

สัญญาณภาพและเสียงกอนการบันทึกไฟลภาพลง 

Flash Drive ดวยเครื่องคอมพิวเตอร จากนั้นจึงทำ

การ Import ไฟลภาพกราฟก เข าส ู  เครื ่องสลับ

สัญญาณภาพและเสียง 

 

 

5.3 ขอเสนอแนะ 

 จากปญหาและอุปสรรคที่เกิดขึ้นในการผลิตภาพกราฟกในการถายทอดสดผานระบบอินเทอรเน็ต 

ของกลุมพัฒนานวัตกรรมและเทคโนโลยีการศึกษา สำนักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัย

เทคโนโลยีราชมงคลพระนคร ขอสรุปแนวทางหรือวิธีการปรับปรุงประสิทธิภาพในการการผลิตภาพกราฟกใน

การถายทอดสดผานระบบอินเทอรเน็ต ดังน้ี 

1) ในการรวบรวมขอมูลควรประสานงานกับเจาหนาที่ผู จัดงานทุกครั้ง เพื่อใหไดขอมูลที่ถูกตอง 

ครบถวน 

2) ศึกษาการทำงานของโปรแกรม Adobe Photoshop เพิ่มเติม เพื่อหาทางแกไขเมื่อตัวโปรแกรม

เกิดปญหาในการทำงาน 

ตารางท่ี 5-22  ปญหาการปฏิบัติงานดานอุปกรณการทำงาน 
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3) ศึกษาการทำงานของเคร่ืองสลับสัญญาณภาพและเสียงเพื่อลดเวลาในการทำงาน เน่ืองจากเคร่ือง

สลับสัญญาณภาพและเสียงแตละรุนมวีิธีการทำงานที่แตกตางกัน รูปแบบของไฟลกราฟกที่จึง

แตกตางกัน 

4)  ศึกษาหาความรูจากแหลงขอมูลตาง ๆ เพิ่มเติม เพื่อนำความรูมาทบทวนและปรับปรุงการ

ปฏิบัติงาน 
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